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Access to economically viable renewable energy sources is essential for the 

development of a globally sustainable society. Solar energy has a large potential to satisfy 

the future need for renewable energy sources.   

Dye sensitized solar cells are a third generation of photovoltaic technologies with 

the potential for low cost environmentally safe energy production. Commercialization of 

this technology requires that dye sensitized solar cells with higher efficiencies can be 

fabricated on flexible substrates. 

The commonly used material for the anode in a Dye Sensitized Solar Cell consists 

of titanium dioxide nanoparticles covered with a layer of light sensitizing dye. For 

efficient electron transport throughout the nanoparticle network, good particle 

interconnections are necessary. For low temperature processing these interconnections 

can be achieved through a hydrothermal process. The focus of this research is to 

understand at a fundamental level this reaction-based sintering process. 

A titanium alkoxide precursor was mixed with commercial titania nanoparticles 

and coated on a transparent conductive oxide substrate. The product of the hydrolysis and 
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condensation of the alkoxide served to connect the nanoparticles thus improving the 

electrical conduction of the titania electrode; this was confirmed by solar cell testing and 

electrochemical impedance spectroscopy.  

To further understand the formation of interconnections during reactive sintering, 

a model system based on inert silica particles was investigated. Titanium alkoxide 

precursor was mixed with commercial silica particles and reacted. Three different types 

of silica particles were used: each with a different morphology. The silica-titania 

multilayers/powders were characterized using SEM, XRD and BET. The efficiency of 

DSSCs is higher when larger non-porous silica particles are used and thin nanocrystalline 

titania is coated on this superstructure. This gave insight into the locations where the 

reactive liquid finally goes as these reactions are carried out. 

 As a further extension of this study, thin layers of this same kind of silica-

titania composite were obtained by spin coating a titanium alkoxide sol mixed with 

monosized 500nm silica particles. SEM was used to examine the morphology of the 

contact/neck formation. Image analysis was done to quantify the effect of key process 

parameters on the average neck width at 2-particle contact points.  

 The use of image analysis to study mixed oxide sub-monolayers in this 

way is the first of its kind. These observational tools and the model system approach 

developed in this research could be applied to many systems that are of interest for 

optical and mechanical applications. 
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CHAPTER 1. INTRODUCTION 

 

We get most of our energy from nonrenewable energy sources, which include the 

fossil fuels - oil, natural gas, and coal [1]. The increasing costs and environmental impact 

of these energy sources has brought greater focus on the development of renewable 

energy technologies using wind, hydroelectricity, biomass, geothermal and solar.  

Alternate energy technologies such as solar can diversify our energy supply, reduce our 

dependence on imported fuels, improve air quality, and offset greenhouse gas emissions. 

 

1.1 Solar cells 

Solar energy refers to the utilization of energy from the Sun. The sun‟s heat and 

light are an abundant source of energy that can be harnessed in various ways such as 

concentrating solar power systems, photovoltaic systems and solar heating. One of these 

applications, the photovoltaic system, converts sunlight into electrical energy. 

Photovoltaic cells are semiconductor devices that generate direct current when they are 

illuminated by photons. They can be used in a wide range of products, from small 

consumer items to large commercial solar electric systems. Photovoltaic systems have no 

moving parts, are modular and easily expandable. These advantages combined with the 

benefits of energy independence and environmental compatibility make this a very 

attractive technology.  

Crystalline silicon PV cells are the most common photovoltaic cells in use today. 

They are also the earliest successful PV devices [2]. Although crystalline silicon devices 

have dominated the commercial marketplace for over two decades, manufacturing is 

http://en.wikipedia.org/wiki/Sun
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highly capital intensive, as the cells require extremely clean Si wafers and very stringent 

processing conditions. 

The high cost of crystalline silicon has led to the development of less expensive 

materials such as cadmium telluride (CdTe) and copper indium (gallium) diselenide 

(CIGS). 

Although these thin film technologies are very promising, the limited availability of 

indium and tellurium and toxicity issues related to cadmium are some of the challenges 

that need to be addressed.  

Photo-electrochemical cells such as dye sensitized solar cells (DSSC) are a more 

cost effective alternative to p-n junction based silicon or CdTe/CIGS solar cells. They 

offer many advantages such as: fabrication without expensive and energy-intensive high 

temperature and high vacuum processes, compatibility with rigid as well as flexible 

substrates, easy availability of raw materials and fewer significant health and 

environmental issues. Lower costs of production may compensate for moderate 

efficiencies of dye sensitized solar cells (~11%) [3] as compared to silicon solar cells 

(>20%) [4]. However, to enable long-term use of Dye Sensitized Solar Cells in electricity 

generation, e.g., in grid-connected or stand-alone rooftop applications; significant 

progress in cell efficiency, stability, and lifetime are needed [5].  

 

1.2 Background on Dye sensitized solar cells (DSSC) 

Dye sensitized solar cells (or Grätzel cells) were developed by Michael Grätzel 

and Brian O'Regan in 1991 [6]. In contrast to the all-solid conventional semiconductor 

solar cells, the dye-sensitized solar cell is a photoelectrochemical cell; i.e., it uses a liquid 
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electrolyte or other ion-conducting phase as a charge transport medium. Unlike a silicon 

solar cell, the task of light absorption and charge carrier transport are separated in a 

DSSC. Light is absorbed by a sensitizer, which is anchored to the surface of a wide band-

gap semiconductor, such as titanium dioxide. Charge separation takes place at the 

interface via photo-induced electron injection from the dye into the conduction band of 

the semiconductor. Carriers are transported in the conduction band of the semiconductor 

to the charge collector.  

DSSCs are extremely promising because they require low cost materials and can 

be fabricated with cost effective approaches onto glass or flexible substrates. However a 

lot of challenges in commercialization of this technology remain. These include:  

a. Exploring new dye photo-sensitizers with reduced HOMO–LUMO
1
 gap energy 

which can lead to absorption of broad range of light, associated with improved 

photocurrent density.  

b. Exploring new room temperature ionic liquids to replace electrolytes 

containing volatile solvents, to improve stability of the cell. 

c. Developing low temperature approaches to manufacture titania electrodes onto 

flexible substrates. 

This research work is focused on “c”; the development of low temperature 

sintering methods for titania electrodes to improve the stability and efficiency of flexible 

DSSCs. 

 

 

 

                                                 
1
 HOMO- highest occupied molecular orbital; LUMO-lowest unoccupied molecular orbital 
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1.3 Operating principle of a dye sensitized solar cell 

In its most common form, a dye sensitized solar cell consists of a transparent 

conducting oxide (TCO) coated with a mesoporous semiconductor layer. As the name 

implies, the transparent conducting oxide allows for light transmission and electron 

conduction. The TCO layer is usually fluorine doped tin oxide or indium tin oxide 

sputtered onto a substrate such as glass or a polymer such as PET (polyethylene 

terephthalate). 

The semiconductor layer is composed of oxide nanoparticles sintered for 

electronic conduction. Anatase titania is the most widely used material for the oxide 

layer; though other wide band gap semiconductors such as ZnO and Nb2O5 have been 

investigated [7].  

Attached to the oxide particles is a monolayer of a charge transfer dye (typically a 

bipyridine metal complex). Photoexcitation of the dye results in the injection of an 

electron into the conduction band of the oxide
 
[7]. Since only dye molecules in direct 

contact to the semiconductor electrode surface can separate charges and contribute to the 

current, a porous nanocrystalline TiO2 electrode structure is used to increase the internal 

surface area of the electrode and, thus, increase the number of dye molecules adsorbed on 

the oxide.  

The dye is regenerated by electron donation from the electrolyte, usually an 

organic solvent containing a redox system, such as the iodide/triiodide couple. The iodide 

is regenerated in turn by the reduction of triiodide at the counter electrode, the circuit 

being completed via electron migration through the external load [7]. 
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The difference in the Fermi level of the oxide and the redox potential of the 

electrolyte corresponds to the maximum open circuit output voltage of the cell. The 

electron injection to the semiconductor is much faster than electron relaxation in the 

sensitizer, thus charge separation occurs with a high efficiency.  

A schematic of the regenerative working cycle of the dye-sensitized solar cell is 

shown in Figure 1.1 [8]. The arrows in the schematic illustrate the direction and series of 

electron movement when the cell is light activated.  

The incoming photon is absorbed by the dye molecule which is transformed from 

a molecular ground state S to an excited state S*. The electron is injected into the 

conduction band of the oxide leaving the dye molecule in an oxidized state S
+

. The 

injected electron percolates through the porous nanocrystalline structure to the 

transparent conducting oxide (TCO) layer of the substrate and through an external load to 

the counter electrode. At the counter electrode the electron is transferred to the triiodide 

(

) in the electrolyte to yield iodide (


), and the cycle is closed by reduction of the 

oxidized dye by the iodide (

 in the electrolyte [9].  
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                          Figure 1.1: Schematic of a dye sensitized solar cell
 
[8].   

 

The operating cycle [10] can be summarized in chemical reaction terminology as follows: 

Anode: 

            S hv S*                                 Absorption 

S* S 

e


(TiO2)                        Electron injection  

            2S

 2S


                     Dye Regeneration 

Cathode:  



 e


(Pt)    Electrolyte Regeneration 

Cell: 

            e

(Pt) + hv e


(TiO2) 

An in-depth look at the important steps in the operating cycle of the DSSC follows: 
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1.3.1 Light absorption 

Dye sensitizers serve as the solar energy absorber in DSSC and their properties 

will have a significant effect on the light harvesting efficiency and the overall 

photoelectric conversion efficiency [11].  The ideal sensitizer for dye-sensitized solar 

cells should absorb all light below a threshold wavelength of about 920 nm (or energy > 

1.35eV). The dye should be firmly attached to the semiconductor oxide surface and inject 

electrons to the conduction band with a quantum yield (electrons injected per absorbed 

photon) of unity. It‟s redox potential should be sufficiently high so that it can be 

regenerated rapidly via electron donation from the electrolyte.  

The best photovoltaic performance in terms of both conversion yield and long-

term stability has so far been achieved with polypyridyl complexes of ruthenium and 

osmium [11]. The molecular structure of one such ruthenium based dye cis-

bis(isothiocyanato)bis(2,2'-bipyridyl-4,4'-dicarboxylato)-ruthenium(II)bis-

tetrabutylammonium, commonly known as “N719” is shown in Figure 1.2.  

 

 

 

 

 

 

                             

Figure 1.2: Chemical structure of “N719” dye [12]. 
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1.3.1.1 Spectral response and IPCE (incident photon-to-current efficiency)  

The spectral response of the N719 dye used in a majority of experiments in this 

research work is shown in Figure 1.3. The absorption maxima of the dye in an ethanolic 

solution are located at ~518nm and ~380nm, with the former being more important for a 

range of visible wavelengths. 

 

 

 

 

 

 

 

 

 

 

                

Figure 1.3: Spectral response of the N719 dye. 
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Figure 1.4: Photocurrent action spectra of the “N3 dye” (ligand L-indicated by red line) 

and the “black dye” (ligand L'-indicated by black line) [13]. 

 

Figure 1.4 compares the incident photon-to-current efficiency for two dyes, the 

N3 dye (cis-bis(isothiocyanato)bis(2,2'-bipyridyl-4,4'-dicarboxylato)-ruthenium(II)) and 

the “black dye” tri(cyanato)-2.2'2"-terpyridyl-4,4'4"-tricarboxylate)Ru(II).  

The ruthenium based bipyridyl complexes such as the N719 have given the best 

efficiencies so far but other dyes based on Fe-bipyridyl complexes and organic dyes 

based on cyanine or merocyanine sensitizers have been investigated [14]. This remains a 

fertile area for research. 

 

1.3.2. Charge transfer 

The charge transfer processes in the N719 dye are shown in Figure 1.5. The 

COOH groups of the dye form a bond with the TiO2 surface by donating a proton to the 
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TiO2 lattice. The absorption of a photon by the dye molecule happens via an excitation 

between the electronic states of the molecule
 
[9]. The excitation of the Ru complexes via 

photon absorption is a metal to ligand charge transfer (MLCT). This means that the 

highest occupied molecular orbital (HOMO) of the dye is localized near the metal atom, 

Ru in this case, whereas the lowest unoccupied molecular orbital (LUMO) is localized at 

the ligand species, in this case at the bipyridyl rings.  

At the excitation, an electron is lifted from the HOMO level to the LUMO level. 

Furthermore, the LUMO level, extending even to the COOH anchoring groups, is 

spatially close to the TiO2 surface, which means that there is significant overlap between 

the electron wave functions of the LUMO level of the dye and the conduction band of 

TiO2. This directionality of the excitation is one of the reasons for the fast electron 

transfer process at the dye-TiO2 interface [9]. 

 

 

 

 

 

 

 

 

Figure 1.5: Charge transfer processes between dye and the TiO2 lattice:                                     

1. MLCT excitation, 2. Electron injection and 3. Charge recombination [9]. 
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1.3.3. Charge Transport 

In the DSSCs charge transport occurs by electron transport in the nanostructured 

TiO2 electrode and hole transport in the electrolyte as 

. Injected electrons in the 

conduction band of titania are transported by diffusion towards the back contact and 

reach the counter electrode through the external load. Although the electron transport 

process has been studied more extensively than the hole transport process because of 

several interesting fundamental questions, both charge transport mechanisms are equally 

important for the operation of the solar cell [9]. 

 

1.3.3.1 Electron transport in the titania layer 

The mesoporous semiconductor nanoparticle layer has three main functions: it 

provides a high surface area for dye molecules, it accepts electrons from the dye and it 

conducts electrons to the TCO layer.  

The mesoporosity of this layer is important for two reasons: 

a. it provides a high surface area for dye adsorption which is important since electron 

injection into the semiconductor only happens when the dye molecules are bonded to the 

surface.  

b. it provides a high surface area for the electrolyte ions. The electrolyte penetrates the 

porous film all the way to the back-contact making the semiconductor/electrolyte 

interface essentially three-dimensional
 
[13].  

The mesoporosity allows for effective screening by electrolyte ions of any 

charged species in the nanoparticles [15].  The electrolyte causes a screening effect 
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because of its overall negative charge so that even though it conducts holes away from 

the titania, it actually keeps the electrons from recombining with these holes as well.  

 

Effect of Morphology and Crystal Structure of titania 

A desirable morphology of the films would have the mesoporous channels or 

nanorods aligned in parallel to each other and vertically with respect to the TCO glass 

current collector. This would facilitate charge diffusion in the pores and the mesoporous 

film, give easier access to the film surface, avoid grain boundaries and allow the junction 

to be formed under better control
 
[13]. A number of groups have worked on producing 

titania nanorods and nanotube arrays, a review on fabrication methods and applications of 

titania nanotube arrays can be found in this reference [16].  

TiO2 exists in three different crystalline polymorphs: rutile, anatase and brookite. 

For dye-sensitized solar cells (DSSC) the use of nanoporous anatase has been proven to 

be superior to rutile; this is believed to be related to the structure and chemical 

composition of the TiO2 surface. The band-gap of rutile titania is 3.0 eV and that of 

anatase is 3.2 eV. Therefore, rutile has better visible light response and anatase has better 

photocatalytic activity [17]. The commonly used commercial titania nanopowder “P25” 

(Evonik Degussa) has a composition of ~70% anatase and ~30% rutile. The phase 

transition from anatase to rutile needs significant thermal activation and occurs between 

700 - 1000 °C depending on the crystal size and the impurity content.  
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1.3.3.2 Ion transport in the electrolyte 

The electrolyte in DSSCs is usually an organic solvent containing the redox pair  

I
-
/I3

-
, which works as a hole-conducting medium. At the TiO2 electrode the oxidized dye, 

left behind by the electron injected to the TiO2, is regenerated by the electrolyte in the 

reaction: 

          2S

 2S


                    Dye Regeneration 

while at the counter-electrode I3
-
 is reduced to I

-
 in the reaction  



 e


(Pt)  Electrolyte Regeneration 

The reduction reaction is catalyzed by a thin layer of platinum. The efficiency of a 

DSSC is based on different rate constants for iodine reduction at the front- and counter 

electrode. The iodine reduction at the counter electrode has to be orders of magnitude 

faster than the recombination at the TiO2/electrolyte interface [8].  

The viscosity of the solvent in the electrolyte should be preferably low in order to 

fill large modules by capillary forces. An electrolyte with lower viscosity helps to fill all 

of the pores and small crevices in the mesoporous electrode, allowing for rapid reduction 

of the dye in all places. Today, nitriles are commonly used as a solvent in DSSC 

modules: acetonitrile, propionitrile, 3-methoxypropiontrile. The disadvantage of using 

such a low viscosity solvent is that it often degrades in air and perfect sealing of the cell 

is critical. The liquid electrolytes are also very susceptible to degradation under thermal 

stresses. Upon exposure for prolonged periods to higher temperatures, i.e. 80–85°C, 

degradation of performance has frequently been observed
 
[13]. Research has been carried 

out on electrolytes that contain ionic liquids, which exhibit a negligible vapor pressure 

and a high conductivity at room temperature. Combined with the low-flammability and a 
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wide electrochemical window, ionic liquids are promising candidates to replace the 

organic solvent. The use of ionic liquids such as derivatives of imidazolium salts has 

been widely studied in DSSCs [18-21].  

 

Recombination: 

The dye-sensitized solar cell is based on photoelectrochemical reactions at the 

semiconductor-electrolyte interface, and the operation of the cell is an outcome of 

competing opposite chemical reactions having differing rate constants.  

The kinetic rates important for the DSSC are shown schematically in Figure 1.6 [22].  

 

 

 

 

 

 

 

Figure 1.6: Schematic of the kinetics at the TiO2/N3 dye/electrolyte interface
 
[22]  

As the figure illustrates, the rate of electron injection from the excited dye into the 

conduction band of the TiO2 is one of the fastest chemical processes known occurring in 

the femtosecond time regime.  The rate of back-electron-transfer from the conduction 

band to the oxidized sensitizer follows a multiexponential time law, occurring on a 

microsecond to millisecond time scale
 
[22]. 



 

 

15 

The electron-transfer rate from the I
−
 ion into cations of the N3 dye was estimated 

to be 100 nanoseconds [23]. This is important for obtaining a high cycle life for the dye, 

since lack of adequate conditions for the regeneration can lead to dye degradation. The 

electron conduction through the nanostructured TiO2 has been estimated to occur in the 

millisecond time range.  

 

1.4 Performance characteristics of a DSSC 

1.4.1 I-V characteristics 

A typical I-V curve for a Grätzel cell that used the “black” dye as a sensitizer is 

shown in figure 1.7
 
[22].   

 

 

 

 

 

 

 

 

 

 

Figure 1.7: Photocurrent voltage characteristics of a DSSC sensitized with the “black” 

dye
 
[22] 
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The overall conversion efficiency of the dye sensitized cell is determined by the 

photocurrent density measured at short circuit (Isc), the open circuit photo-voltage (Voc), 

the fill factor of the cell (FF) and the incident power Pin.  

η = Isc × Voc × FF/Pin 

The fill factor is a measure of the squareness of the I-V characteristic curve and is defined 

as:  

FF = PP / (Voc * Isc)  

where PP is the peak power (the maximum power generated by the cell). FF is always 

less than 1. 

The incident photon to current conversion efficiency is represented as a function 

of wavelength and is given by
 
[23]: 

IPCE[%] =  100* {1240[eV · nm] × Jsc[μA/cm
2
] }/ {λ[nm] × Φ[μW/cm

2
] }   

where Jsc is the short-circuit photocurrent density for monochromatic irradiation, λ is the 

wavelength, and Φ is the monochromatic light intensity. 

 

1.5 Motivation for this research work  

Ultimately, the mass production of DSSCs will depend not only on the energy 

conversion efficiency of these devices, but also on how quickly this technology can be 

commercialized; and currently several companies are working in this direction. G24 

Innovations Limited manufactures and designs solar modules using proprietary dye 

sensitized thin film technology. The company uses an automated "roll-to-roll" 

manufacturing process similar to inkjet printing to produce Dye Sensitized Thin Films 

[24]. Solaronix S.A. makes dye solar cell modules that use screen printing technique to 
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make titania electrodes. One of their prototype solar cell modules is shown in Figure 1.8 

[25]. Dyesol Limited develops dye solar cell technology that can be directly incorporated 

into buildings by replacing conventional glass panels. Dyesol develops devices for the 

full range of PV applications using glass, metal, ceramic and plastic substrates. One of its 

interconnected solar cell module designs is shown in Figure 1.9 [26]. 

             Large-scale commercialization of dye solar cell technology demands the use of 

conductive polymer substrates which allow roll-to-roll production to achieve high 

throughput. The use of polymer substrates also facilitates fabrication of flexible, light-

weight and thin DSSCs. Currently, there is a tremendous focus on making such flexible 

solar cells using conductive polymer substrates; and low temperature processing methods 

need to be developed that are compatible with polymer materials.  

This research work is focused on the development of low temperature processing 

methods for titania electrodes to improve the stability and efficiency of flexible DSSCs.  
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Figure 1.8: SERIO 3030W31 – Interconnected dye solar cell module (Solaronix 

SA) [25] 

 

 

 

 

 

 

 

 

                            Figure 1.9: Dyesol Series Interconnect Glass Module [26] 
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1.5.1 Low temperature processing of titania electrode 

For efficient electron transport throughout the TiO2 nanoparticle network, and 

ultimately good power conversion efficiency, good electrical interconnection of the 

nanoparticles is a necessary prerequisite. In devices prepared on glass/FTO substrates, 

best performance is obtained by annealing the electrodes at 450°C which causes necking 

of the TiO2 nanoparticles. This process cannot be used with low-cost flexible plastic 

substrates that cannot sustain temperatures higher than 150°C [27]. Therefore it is 

essential to develop low temperature sintering processes for preparation of the 

nanostructured titania films. 

A variety of methods have been proposed for the low-temperature post-treatment 

of the nanostructured TiO2 films, including room temperature compression techniques 

[28,29] microwave irradiation [30], UV irradiation [31,32] and hydrothermal 

crystallization [33,34]. 

This research is focused on chemical methods involving the reaction of a titanium 

alkoxide precursor to prepare nanostructured titania films with good particle-particle 

interconnections that are essential to achieve good power conversion.  

An important goal of this research is to gain a fundamental understanding of the 

processes that lead to these particle interconnections (necking) and thereby illustrate the 

kinds of hydrothermal treatments that can ultimately be applied to flexible substrates used 

in DSSCs.  

Chapter 2 of this thesis focuses on low temperature processing of titania 

photoanodes by combining commercial titania nanoparticles with a titanium alkoxide in a 

hydrothermal system. Chapter 3 is an overview of the concepts of reactive sintering as 



 

 

20 

applied to dye solar cell fabrication. Chapter 4 focuses on understanding the interparticle 

necking and pore structures created by the titania formation from the alkoxide at the 

macro-level; by substituting the commercial titania nanoparticles with monosized silica 

particles. The effect of silica morphology on the efficiency of silica-titania dye sensitized 

solar cells is discussed. Chapter 5 focuses on further investigations of the neck region 

created by the reactive sintering process; by preparing sub-monolayers of silica-titania 

using monosized 500nm silica particles. Scanning electron microscopy was used to look 

at the morphology of the sub-monolayers and atomic force microscopy was used to 

observe surface topography. Image analysis was done to study the effect of alkoxide 

concentration on the average neck width in 2-particle silica-titania chains. This work 

provides a greater insight into the formation of particle-particle interconnections with 

applications even beyond DSSCs. Concluding remarks are presented and future areas of 

work are outlined in Chapter 6. 
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Chapter 2. Low temperature hydrothermal processing of titania electrodes  

 

2.1 Background 

The conventional methods of preparing titania electrodes for dye sensitized solar 

cells involve coating a precursor, usually a colloidal suspension of titania nanoparticles 

onto glass substrates using coating techniques such as doctor-blading, dip-coating or 

screen printing. Organics are added to the TiO2 precursor formulations to improve the 

quality of the film by breaking down agglomerates, to stabilize TiO2 suspensions, and to 

increase the wetting capacity of the precursor mixture [35]. The titania film is then 

sintered at high temperatures of 400-500 °C in order to remove the organic additives 

from the precursor and improve interconnection of the particles.  

Sintering enables the production of more uniform TiO2 thick films without large 

pores or cracks. Sintering also improves the connection between the nanocrystallites that 

constitute the film (necking), and the adherence of the film to the transparent conducting 

oxide (TCO) coated substrate [35]. 

  The disadvantage of a high temperature sintering process is that it cannot 

be applied to substrates such as plastic that are polymers which can be 

deformed/damaged at high temperatures. Polyethylene terephthalate (PET) is one of the 

plastic substrate materials that has been tested in DSSCs. The PET substrates are coated 

with a transparent conductive oxide such as indium tin oxide (ITO) to make them 

conductive. 

  Use of high temperature sintering is not viable in the case of PET 

substrates as they can damage the substrate and increase the resistivity of the ITO layer. It 
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is therefore necessary to develop low temperature sintering methods for flexible DSSCs; 

but significant challenges remain in improving the performance and stability of these 

cells as compared to DSSCs fabricated on rigid glass substrates.  

Several research groups have studied the change in the efficiency of DSSCs with 

different sintering temperatures
 
[36,37]. For example, Nakade et al [36] have studied the 

energy conversion efficiencies of solar cells sintered at 150 °C and 450 °C for three 

different TiO2 synthesis methods (hydrolysis of aqueous TiCl4 solution, hydrolysis of 

titanium tetraisopropoxide in nitric acid and use of commercial titania nanoparticle 

(P25)). In all three cases, the efficiency of films annealed at 150 °C is lower than those 

annealed at 450 °C. The lower efficiencies were attributed to lower short circuit current 

values. The diffusion lengths of the 150 °C annealed films were much lower than those of 

450 °C annealed films. The longer diffusion lengths of high-temperature annealed films 

were attributed to the neck growth between particles and a decrease in charge trap 

density.  Lowering the annealing temperature while improving the efficiency is one of the 

key challenges toward the commercialization of DSSCs.   

 

2.2 Literature Review 

A number of different low temperature annealing routes have been proposed. 

Mechanical compression of the TiO2 films for short time intervals has been demonstrated 

on glass and plastic substrates; and efficiencies of 5.5% have been reported for titania 

pressed onto ITO-PET substrates [29].  

UV irradiation followed by a low temperature annealing at 140 °C has been used 

to remove organic residues and improve the performance of the TiO2 electrode used in 
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flexible DSSCs [31]. UV irradiation allowed degradation of surfactants used in the titania 

suspensions, but the efficiency of these cells was quite low (0.23%) compared to the 

electrodes prepared on glass substrates (0.45%). 

UV irradiation has also been studied in experiments using a mixture of a 

commercial TiO2 powder (Degussa P25) and a titania precursor 

(titanium(IV)bis(ammonium lactato)dihydroxide) by Gutiérrez-Tauste et al. [35]. UV 

treatment leads to decomposition of the titania precursor as a result of the photocatalytic 

activity of nanocrystalline TiO2 present in the mixture, thus producing titania electrodes 

at low temperatures of 80 °C.  

Miyasaka et. al. have reported the use of an aqueous colloidal sol of titanium 

oxide containing brookite-type nanocrystalline TiO2, used as an interparticle connection 

agent [38].  Interparticle connection was assumed to proceed by dehydration of the 

hydrogen-bonded network of TiO2 nanoparticles. DSSC efficiencies as high as 6.4% have 

been reported on ITO coated PEN (polyethylene naphthalate) plastic sheets prepared by 

this method.  

 While these studies all show promise, much improvement in efficiency 

with lower temperature processing is still necessary to reach a viable flexible DSSC cell. 

 

2.2.1 Hydrothermal treatments using strong acid and/or strong base 

There is a large literature base on the formation of high surface area titania using 

acid or base chemistries in which titania nanoparticles (such as P25) dissolve and 

reprecipitate and form nanofibers, nanorods or nanotubes at temperatures below 150 °C. 

Kasuga et al [39] reported that when anatase-phase or rutile-phase-containing TiO2 was 
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treated with an aqueous solution of NaOH for 20 h at 110 °C and washed with HCl and 

distilled water, needle-shaped TiO2 products were obtained. They report that the 

crystalline raw material is first converted to an amorphous product through alkali 

treatment, and subsequently, titania nanotubes are formed after treatment with distilled 

water and HCl aqueous solution.  

Similarly Nian et al [40] have reported that the hydrothermal treatment of titanate 

nanotube suspensions under an acidic environment resulted in the formation of single-

crystalline anatase nanorods. The nanotube suspensions were prepared by treatment of 

TiO2 in NaOH, followed by mixing with HNO3 to different pH values. These suspensions 

upon a hydrothermal treatment at 175 C formed anatase titania nanorods.  

 

2.2.2 Hydrothermal treatments at ~neutral pH 

Although the acid-base chemistries give high aspect ratio nanostructures that 

improve performance in a DSSC (due to greater dye adsorption and faster electron 

conduction), the processes involved are mostly batch-type and cannot be used with 

substrates such as ITO coated PET which are affected by strong acid or strong base. 

Hence the need for processing methods that can be carried out at neutral pH, without 

acids or bases that can damage the polymer substrate.  

A few studies have focused on the hydrothermal treatment of a titania precursor 

(under neutral pH) mixed with a commercial titania powder such as P25 (Degussa). The 

precursor is converted to titania through a sol-gel condensation process and the titania 

thus formed serves as interconnections between the P25 particles. In one approach, 
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titanium tetraisopropoxide
2
 (TTIP) has been used as a cross-linking agent mixed with a 

slurry of Degussa P25 TiO2 nanoparticles dispersed in methanol. When the coatings were 

exposed to moderate heat (50 °C) and moisture (20%RH), sol-gel condensation between 

the TiO2 nanoparticles and the TTIP resulted in improved electrical interconnection of the 

particles. A large increase in short-circuit current and fill factor was observed in DSSCs 

using FTO coated glass substrates when 25wt% of titanium tetraisopropoxide was added 

to P25 particles and the efficiencies increased from 1.01% for cells with no TTIP added 

to 2.43% for cells with 25wt% TTIP added [27].  

Zhang et al. have used an aqueous or ethanolic paste of nanocrystalline titania P25 

and titanium salts such as TiCl4, TiOSO4 and alkoxides of titanium in a steam treatment 

process at 100 °C [41]. They claim that under hydrothermal treatment at 100 °C in the 

solid-gas (film-water vapor) interphase, the added titanium salts hydrolyzed or 

crystallized into either anatase or rutile TiO2 acting as “glue” to chemically connect the 

titania particles to form mechanically stable porous films. DSSCs employing these porous 

electrodes achieved efficiencies of up to 4.2%. A schematic of the process is shown in 

figure 2.1. 

 

 

 

 

 

  Figure 2.1: Schematic of the film formation during hydrothermal crystallization at the 

gas/solid interface [41] 

                                                 
2
TTIP: Titanium tetraisopropoxide; chemical formula: Ti{OCH(CH3)2}4 
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2.2.3 Chemistry and Mechanism   

The mechanism proposed for the hydrothermal process using a titanium alkoxide 

precursor is a sol-gel condensation between the TiO2 nanoparticles and the alkoxide in the 

presence of water [27]. 

4TiO2 + Ti(OR)4 + 4H2O → Ti(OTi)4 + 4ROH  (where R = C3H7)       [27] 

which can be written in two separate steps as follows:  

Hydrolysis Reaction: Ti-OR +H2O     →       Ti-OH +ROH 

Condensation:            Ti-OH + Ti-OR    →      Ti-O-Ti + ROH 

Miyasaka et al
 
[38] have proposed an alternate mechanism for interparticle 

connection based on a hydrogen-bonded network of particles with surfaces covered with 

hydroxyl groups. Instead of a molecular titania precursor, a colloidal sol of brookite-type 

nanocrystalline TiO2 is used as the interparticle connection agent. Figure 2.2 illustrates 

this mechanism. 

 

 

 

 

 

 

Figure 2.2: A mechanism for interparticle connection of nanocrystalline TiO2                         

particles dispersed in an aqueous medium via formation of a hydrogen-bonded network 

[38]. 
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2.3 System of approach 

The low temperature method followed in our experiments involves the 

hydrothermal treatment of a titania precursor (under neutral pH) mixed with a 

commercial titania powder such as P25 (Degussa). The precursor is converted to titania 

through a sol-gel condensation process and the titania thus formed serves as 

interconnections between the P25 particles.  

2.3.1. Materials and Methods 

Commercial titania P25
3
 nanopowder (Aeroxide P25) was purchased from Evonik 

Degussa. TTIP and ethanol (99.5% pure) were purchased from Sigma-Aldrich. The 

substrates used for the experiments were FTO coated glass (10<R<20Ω/sq) obtained 

from Flexitec Eletrônica Orgânica Ltda.  

The steam treatment was performed by preparing a 1M (molar) solution of TTIP 

in ethanol and adding the required amount of P25 powder. To 3.6g of the TTIP solution, 

0.1g of P25 is added. This gives a weight ratio of 0.95:0.1 for TTIP:P25 in the dispersion. 

There should be minimal amount of TTIP exposure to the atmosphere during the 

preparation of this dispersion to prevent hydrolysis of TTIP. The mixture of TTIP 

solution and P25 is then blade coated onto the FTO glass substrates. Blade coating is 

performed by placing a few drops of the dispersion on the FTO glass slide and using a 

sharp blade to spread the dispersion onto the glass slide. This process can be repeated 

depending on the desired thickness of the films. The blade coated samples are placed on a 

Petri dish and steam treated at the desired temperature (110-130 °C) by placing the Petri 

dish in a beaker containing DI water. The procedure is shown schematically in Figure 

2.3. After steam treatment, the samples are dried at room temperature. The dried samples 

                                                 
3
 P25 is a highly dispersed titanium dioxide available from Evonik Degussa  
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are then used for different characterization studies. To obtain powder samples for XRD 

characterization, the same procedure was used but instead of blade coating the dispersion 

onto FTO coated glass slides; the dispersion was directly treated under steam while being 

constantly stirred at a speed of 200rpm.  

 

 

 

 

 

 

Figure 2.3: Schematic of experimental setup for steam treatment method 

 

2.3.2 Physical characterization (Morphology and Phase) 

The thickness of the films was determined using a Tencor alpha-step200 

profilometer. Scanning electron microscope (GEMINI ZEISS FESEM) with an Everhart-

Thornley (E-T) detector was used to study morphology of nanoparticle structures and 

interconnections. Carbon tape was used to stick the samples onto the aluminum SEM 

studs. Gold coating using a sputter deposition system was done on the samples to make 

them conductive. XRD (Siemens Kristalloflex diffractometer : Cu Kα source at 40kV and 

30mA) was used to study crystallinity and phase of titania. 

The SEM images of the reactant mixture before steam treatment and product 

obtained after steam treatment for two magnification settings (10000 and 30000) are 

shown in Figure 2.4. In the SEM image on the left, it appears that the unreacted titania 

precursor is covering all the P25 particles, and the image on the right shows the 
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transformation of this precursor after steam treatment. A number of larger aggregates in 

various sizes and smaller particles are also seen. The image at 30KX magnification 

reveals in greater detail the rough surface of the titania obtained after steam treatment. It 

can be noted from the image on the right in Figure 2.3 that the P25 aggregates are not 

easily distinguishable from any titania that is formed by hydrothermal treatment of the 

titania precursor.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.4: SEM image of titania precursor + P25 mixture before (left) and after (right) 

steam treatment.  
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To determine the phase of the reactant mixture before steam treatment and 

product obtained after steam treatment, an XRD of the material was performed before 

and after steam treatment and the result is presented in Figure 2.5. The XRD pattern 

shows anatase and rutile TiO2 peaks as well as several smaller peaks. From the XRD 

pattern of the powder obtained after steam treatment, the distinction between the TiO2 

peaks from the P25 powder and any possible TiO2 peaks from the titania precursor is not 

clear. The appearance of several smaller peaks also points to the presence of 

organics/impurities that have not been completely removed from the powder. It is worth 

noting that the commercial Degussa P25 TiO2 consists of ~70%anatase and ~30% rutile 

phases.  
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 Figure 2.5: XRD before (top) and after (bottom) steam treatment. 

 

2.3.3 Electrical characterization (I-V characteristics and electrochemical  impedance 

spectroscopy) 

To determine the effect of the steam treatment on the efficiency of dye sensitized 

solar cells; a number of samples were blade coated, steam treated, dyed and tested. For 

these experiments, a mixture of P25 and titanium tetra isopropoxide (TTIP) was prepared 

in 5 ml methanol (99.8% pure) for five different weight ratios of P25:TTIP; namely 1:0, 

1:0.25, 1:0.5, 1:0.75 and 1.0:1.0g. This dispersion is blade coated onto clean FTO 
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(fluorine doped tin oxide) glass slides; the number of coatings determines film thickness. 

A drop of TritonX-100 surfactant is added to the dispersion to improve adhesion of the 

films to the substrate.    

The thickness of all the coatings are maintained in the range of 14-17 μm by 

varying the number of times the sample is blade coated. The films are treated in air for 30 

minutes and dried at 150 °C for 30 minutes. The dried coatings are placed in a solution of 

0.28mM ruthenium dye in ethanol overnight. The ruthenium dye used is Ruthenizer 535 

bis-TBA (N719); a commercial dye available from Solaronix. The dyed samples are 

rinsed with ethanol, dried at room temperature and used as the anode. Platinum sputtered 

on FTO coated glass is used as the cathode.  

Dye sensitized solar cell assembly 

The dye sensitized solar cells were assembled by sandwiching the electrolyte 

between the photocathode and photoanode. A 25µm thick polyolefin separator membrane 

approximately 1 square inch in area is dipped into the electrolyte solution and placed on 

the photoanode. The electrolyte used for the I-V characterization has the following 

composition:  LiI (0.5M), I2 (0.05M), 4-tert-butyl-pyridine (0.5M) in 5mL of 

methoxypropionitrile solvent. On the top of this assembly the platinum coated FTO glass 

slide (photocathode) was placed in such a way that some bare FTO substrate was exposed 

for making external electrical connections. In the end, a mask with 0.25 cm
2

 area hole 

was placed on the back side of the photoanode and the whole assembly was held together 

using two binder clips. The process of assembling the solar cell is shown stepwise in 

Figure 2.6.  
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     Figure 2.6: Schematic of a step-by-step assembly of a DSSC 
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2.3.3.1 I-V characteristics 

A solar simulator is used to obtain I-V characteristics of the DSSC. Since the cells 

were not completely sealed, but just held together using the binder clips, they were 

assembled in the solar simulator lab just before measuring the current-voltage 

characteristics. This was done to reduce the effect of electrolyte evaporation on solar cell 

performance. The assembled solar cells were placed on a table at a fixed height in such a 

way that the light output from the 300 W Xenon solar simulator (Newport, Oriel 91160A) 

[42] on the cell was 90 W/m
2

 measured by an irradiance meter (Daystar, Solaqua). The 

entire simulator setup is shown in Figure 2.7. The light was passed through the 0.25 cm
2

 

mask on the photoanode. Alligator clips were used to make the electrical connections. 

They were connected on the other side to a voltage source (HP 4140B pA meter/voltage 

source). A Labview program was used on the solar simulator as well as on the electrical 

characterization equipment through which -0.3 to 1.0 volts were fed to the solar cell with 

a step size of 10 mV. The photo current was collected in the dark and under 90 W/m
2

 

illumination. The output was represented in two formats: current vs. voltage data points 

and calculated solar cell characteristics such as efficiency, fill factor, short circuit current, 

and open circuit voltage.  
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Figure 2.7: a. Newport solar simulator and computer and b. the voltage supply. 

 

The I-V characteristics obtained for 5 different TTIP:P25 weight ratios are shown 

in figure 2.8 and table 2.1. Generally speaking, the addition of the TTIP has increased the 

performance, at least up to a point where the addition is pushing the P25 particles apart 

from each other and lowering the current output. 
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       Figure 2.8: I-V characteristics of DSSCs for 5 different TTIP:P25 weight ratios. 

 

              Table 2.1: I-V characteristics of DSSCs for 5 different TTIP:P25 weight ratios.  

 

 

 

 

 

 

 

 

 

 

 

 

 

    

TTIP:P25 

(wt%) 

Isc 

(mA/sq.cm) Voc (V) FF 

Efficiency=η

(%) 

0% 3.28 0.67 0.68 1.48 

25% 4.76 0.67 0.69 2.09 

50% 4.64 0.67 0.63 1.85 

75% 3.28 0.68 0.75 1.69 

100% 3.08 0.65 0.74 1.46 
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From the I-V characteristics of the DSSCs it can be seen that the addition of TTIP 

(25 wt%) improves the efficiency of DSSCs. We infer that this is due to the improvement 

in the P25 particle interconnections. The increase in efficiency on addition of TTIP is 

mainly due to the increase in short circuit current in the cell. However, there is an 

optimum TTIP amount beyond which efficiency decreases probably due to more 

amorphous titania covering the P25 particles. The addition of more TTIP could also lead 

to lower porosity which can then cause lower dye adsorption and, thus, lower short circuit 

current.  

 

2.3.3.2 Electrochemical impedance spectroscopy (EIS) 

EIS is a steady state method used to obtain the electrical response of an 

electrochemical cell to an applied AC potential over a range of frequencies [43]. 

Electrochemical impedance is usually measured with a very small input signal, which 

does not perturb the system much. The data is represented as the Nyquist plot or Bode 

plot and analyzed by fitting to an equivalent electrical circuit model, based on the 

physical electrochemistry of the system. 

EIS was used to study charge transport processes in a DSSC as the weight ratio of 

TTIP to P25 is varied. The electrochemical impedance spectroscopy was performed using 

an impedance analyzer (Solartron analytical, 1255B) connected to a potentiostat 

(Solartron Analytical, 1287). The EIS spectra were measured over a frequency range of 

10
-1

 to 10
6

 Hz at 298 K under open circuit condition with 10 mV amplitude. The electrical 

impedance spectra were characterized using the Z-View software (ZView Version 3.1 

Scribner Associates Inc.) 
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EIS data are usually represented in the form of either a Nyquist plot or a Bode 

plot. Nyquist Plots are a way of showing frequency responses of linear systems.  Nyquist 

plots display both amplitude and phase angle on a single plot, using frequency as a 

parameter in the plot. Bode plots use frequency as the horizontal axis and use two 

separate plots to display amplitude and phase of the frequency response. Bode plots are 

really log-log plots, so they collapse a wide range of frequencies (on the horizontal axis) 

and a wide range of gains (on the vertical axis) into a viewable whole [44].   

Figures 2.9 and 2.10 show the Nyquist and Bode plots for DSSCs prepared for five 

different TTIP:P25 weight ratios.  
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Figure 2.9: Nyquist plot of impedance spectra for DSSCs prepared for 5 different 

TTIP:P25 ratios 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.10: Bode plots of impedance spectra for DSSCs prepared for 5 different 

TTIP:P25 ratios 
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Under ideal conditions, the Nyquist plot of a typical dye sensitized solar cell 

shows three semicircles, corresponding to the three main photoelectrochemical processes 

occurring during the cell operation: Nernst diffusion of iodine/iodide species through the 

electrolyte and titania coating, electron transfer at the titania/dye/electrolyte interface and 

electron transfer at the counter electrode [45-47]. The semicircle associated with the 

Nernst diffusion process is usually seen at frequencies between 0.01 to 0.1 Hz and 

therefore requires a long recording time. The cells tested in the present research were not 

completely sealed; therefore the EIS data acquisition time was limited to a couple of 

minutes per cell. Therefore the frequency range selected for the EIS data acquisition was 

from 0.1 Hz to 10
6

 Hz, which means, only two semicircles associated with the Pt 

electrode interface and the TiO2/dye/electrolyte interface were usually observed. 

 The semicircle in the low frequency region (larger semicircle) is attributed to 

the charge transfer in the TiO2/dye/electrolyte layer  

 The semicircle in the high frequency region (smaller semicircle) is attributed 

to the electrochemical reaction at the Pt counter electrode  

In the Nyquist plot of figure 2.9, the 25wt% TTIP cell showed the least impedance as 

seen from the diameter of the low frequency semicircle which suggests that the addition 

of 25 wt% TTIP has improved the particle interconnections in the titania electrode. 

In the Bode plot of figure 2.10, it can be seen that the characteristic frequency is 

higher for the 0%TTIP sample showing that the electron lifetime in the TiO2 layer is 

lowest when no TTIP is added. This helps explain how the addition of TTIP helps 

increase short circuit current. 
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The impedance plots are fitted to an equivalent circuit model (Figure 2.11) using the 

Zview software (Scribner Associates Inc.) and the model parameters are shown in Table 

2.2. 

 

 

 

                 Figure 2.11: Equivalent circuit model used to represent interfaces in DSSCs 

 

 

 

Table 2.2: R and C parameters obtained from fitting the data to the equivalent 

circuit model 

 

 

 

 

 

  

 In Table 2.2 Rs represents impedance of FTO layer and FTO/TiO2 interface, R1 

and CPE1 (constant phase element) together represent the electrochemical reaction at the 

Pt counter electrode, and R2 and C2 represent the transfer in the TiO2/dye/electrolyte 

layer. Variation in Rs (25-40Ω) is partly attributed to variation in the resistivity of the 

FTO glass substrates; variation in R1 is attributed to the separator area between the titania 

layer and the Pt electrode. The gradual increase in the R2 value as %TTIP goes from 0% 

to 75% may be associated with a lower level of crystal perfection of the crystallized 

%TTIP Rs(Ω) R1(Ω) R2(Ω) C2(F) t=R2*C2(s)  

            

0% 34.67 106.9 27.7 0.0004 0.011 

25% 31.89 21.38 54 0.0013 0.070 

50% 37.03 16.04 65.5 0.0011 0.073 

75% 24.01 43.72 83.9 0.0009 0.077 

100% 40.27 43.15 55.2 0.0013 0.074 
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titania that is formed and possibly lower conduction rate between the P25 particles in the 

coating.  

 

2.3.4 Effect of cell illumination on DSSC performance 

In section 2.3.3, we discussed the performance of dye sensitized solar cells for an 

illumination intensity of 90 mW/cm
2
. In this section we will discuss the performance of 

dye sensitized solar cells with varying illumination intensities. For this study, solar cells 

were prepared and assembled as discussed in section 2.3.3. The illumination was adjusted 

on the simulator and the following intensities were used: 60,100,150 and 200 mW/cm
2
. 

The results of I-V characterization for these 4 intensities are shown in Table 2.3 for 5 

weight ratios of TTIP:P25.  

From the table it can be noted that an increase in illumination causes an increase 

in short circuit current for all ratios of TTIP:P25 tested. This is probably due to the 

proportionately larger number of electrons being injected into the TiO2 particles at higher 

illumination intensities. The highest short circuit current density of 8.24 mA/cm
2 

was 

obtained for the cell prepared with 25wt% TTIP. This increase in short circuit current 

density is mainly responsible for the increasing efficiency of the cell when the 

illumination is higher. A slight increase in Voc was also observed with increasing 

illumination intensity. No particular trend was observed with respect to the fill factor. 

The maximum DSSC efficiency of 1.92% was obtained for the 25 wt% TTIP cell under 

an illumination of 100 mW/cm
2
.  
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Table 2.3: Solar cell efficiencies at different illumination intensities 

 

              

 

 

 

 

 

 

 

        

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Pin(mW/cm
2
) Voc(V) Isc(mA/cm

2
) FF Eff (%) 

0%TTIP      

 60 0.59 1.03 0.52 0.53 

 100 0.61 1.70 0.56 0.59 

 150 0.63 2.48 0.61 0.63 

 200 0.64 3.16 0.61 0.62 

      

25%TTIP 60 0.66 2.26 0.72 1.80 

 100 0.68 3.98 0.71 1.92 

 150 0.69 6.09 0.69 1.92 

 200 0.7 8.24 0.65 1.87 

      

50%TTIP 60 0.6 1.72 0.54 0.92 

 100 0.63 3.01 0.63 1.20 

 150 0.65 4.58 0.66 1.30 

 200 0.66 6.02 0.67 1.33 

      

75%TTIP 60 0.62 1.82 0.73 1.37 

 100 0.66 3.19 0.70 1.47 

 150 0.68 4.75 0.68 1.47 

 200 0.69 6.53 0.65 1.46 

      

100%TTIP 60 0.6 1.65 0.72 1.19 

 100 0.67 2.50 0.71 1.19 

 150 0.7 3.74 0.72 1.26 

 200 0.71 5.07 0.70 1.25 
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2.3.5 Effect of type of alkoxide on DSSC performance 

Dye sensitized solar cells were prepared and assembled as described in section 

2.3.3 with a different titanium dioxide precursor (titanium butoxide
4
 instead of titanium 

isopropoxide). As with the TTIP, five weight ratios of titanium butoxide (TB):P25 were 

tested. The thickness of the coatings as measured in the profilometer was in the range of 

40-45μm. The thickness of the layers prepared with titanium butoxide were thicker than 

those prepared with TTIP. The solar cell test data for five ratios of TB:P25 at an 

illumination of 90 mW/cm
2
 is shown in Table 2.4. 

 

              Table 2.4: I-V characteristics of DSSCs for 5 different TB:P25 weight ratios 

 

 

 

 

 

 

 

From the table, we can see that the efficiency is highest for a 25wt% addition of 

titanium butoxide and the trend is similar to that observed with TTIP (Table 2.1). 

However, the overall efficiencies are lower than 2%. One reason for this could be the 

higher thickness of these films. Optimum thickness is very important as a thinner coating 

does not absorb the incident light completely. Thicker coatings capture the light 

completely, but add too much conduction distance through the sintered titania matrix. 

Generally it has been observed that a 10 to 15 μm thick film is optimum [6]. 

                                                 
4
 Titanium (IV) butoxide (TB): chemical formula: Ti(OCH2CH2CH2CH3)4 

TB:P25 

(wt%) 

Isc 

(mA/sq.cm) Voc (V) FF 

Efficiency=η

(%) 

0% 0.90 0.65 0.79 0.51 

25% 3.30 0.66 0.72 1.75 

50% 3.42 0.61 0.66 1.54 

75% 2.38 0.60 0.74 1.18 

100% 1.96 0.60 0.70 0.91 
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2.4 Summary 

 From the I-V and EIS characterization it is clear that although the addition of 

TTIP or TB enhances the short circuit current of the DSSC (up to a certain weight ratio); 

the overall efficiencies of the best performing cells were still only around 2%. To be 

competitive with other solar cell technologies, we believe that the efficiencies of these 

low temperature sintered cells should be at least 7-10%. It would be interesting to see if 

this could be achieved by tailoring the microstructure of the titania electrode so that the 

low temperature sintering process creates better particle interconnections which can then 

lead to higher short circuit currents. 

 It is therefore useful to look into the role of the reactive titania precursor in 

greater detail; particularly relating to the formation of the interconnections between the 

host particles (such as P25). In chapter 3 we have developed a theoretical framework to 

understand the formation of such interconnections. In chapters 5 and 6 we have aimed 

our experiments to understand how the reacted material collects at the interparticle necks. 

This was studied by using an oxide material (silica) in place of the P25 to be able to 

clearly pinpoint the titania signal from the TTIP without any interference due to the 

titania signal from the P25 nanopowder. 
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Chapter 3. Chemical Sintering Applied to Dye Solar Cell Fabrication 

In Chapter 2, the low temperature processing of titania electrodes using a reactive 

titanium alkoxide precursor was discussed. The focus of chapter 2 was on improving the 

efficiency of the dye sensitized solar cell by the addition of varying amounts of a titanium 

alkoxide precursor. While it is very important that the addition of the reacted titania 

improve the efficiency of the dye sensitized solar cells, several other characteristics of the 

titania electrode also need to be considered. These include: surface area, porosity, and 

interconnectivity in the microstructure (particle necking). A high surface area and 

porosity can allow a large quantity of dye to be adsorbed, which means a large quantity 

of photons are available for dye excitation. Good interconnections between TiO2 particles 

are essential to ensure rapid electron transport in the TiO2 film.  

3.1 Surface Area  

The electron-collecting layer in a DSSC is typically a 10 μm thick nanoparticulate 

film, with a three-dimensional network of interconnected 15–20nm sized nanoparticles 

[48]. The surface area of widely used Degussa P25 titania nanoparticles is in the range of 

50-60 m
2
/g [49,50]. Higher surface area of titania nanoparticles would allow more dye 

adsorption and light harvesting. Because of the importance of microstructure in 

influencing the performance of DSSCs, a variety of approaches have been used to try and 

reach improved cells. Two of the distinctly novel ways will be reviewed here, followed 

by a detailed discussion of how nominally spherical particles “fit” together in more 

conventional microstructures.  The two novel approaches are:  

1. Ordered titania nanotube or nanorod arrays 

2. Core-shell particles with a mesoporous titania shell layer 
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3.1.1 Nanotubes/Nanorods 

Nanotubes and nanorods of titania have been widely studied in DSSCs due to 

their high surface-to-volume ratios and size dependant properties. The arrangement of 

highly ordered titania nanotube arrays perpendicular to the surface of the substrate 

permits facile charge transfer along the length of the nanotubes from the solution to the 

conductive substrate, thereby reducing the losses incurred by charge-hopping across the 

nanoparticle grain boundaries. Easier access to the nanotube array surface, as well as 

better control of the interface makes this morphology desirable for DSSCs. The 

enhancement in the electronic transport also allows for improved light harvesting as 

thicker films can be used to increase the optical density, thus improving the absorption of 

low-energy photons in the red and infrared without losing the additionally harvested 

charge carriers to recombination [16]. Figure 3.1 shows a schematic of a nanotube array 

based DSSC.  

 

 

 

 

 

 

 

 

 

Figure 3.1: Illustration of a DSSC based on a titania nanotube array architecture [16].  
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Titania nanotubes and nanoarrays can be produced by a variety of methods such 

as sol-gel, seeded growth, hydrothermal processes and anodization in fluoride baths. 

Although efficiencies of around 7% have been demonstrated [51,52] the processing 

methods generally involve harsh chemicals and moderate to high temperatures and are 

thus not suitable for polymer substrates.  

 

3.1.2 Core-shell structures 

Several core-shell structures based on an oxide core and oxide shell have been 

used in dye sensitized solar cells [53,54]. Silica has also been used as an oxide core due 

to its inertness and ease of availability. Silica-titania core-shell materials have been 

shown to have high photocatalytic activity [55]. Lim et al. [56] obtained homogeneous 

and highly dispersed titania shells on silica spheres by a sol-gel method. The surface 

areas of titania-coated spheres (ST-4x) calcined at 400-600 °C ranged from 107.5 to 44.3 

m
2
/g. In addition, the surface area of the titania shell (44.3 m

2
/g) calcined at 600 °C was 

substantially more than for the free powder (3.8 m
2
/g). Due to the ease of manufacture 

and control over shell thickness that can be achieved by sol-gel synthesis, core-shell 

powders of increased surface area have found a lot of applications. With a suitable titania 

precursor, core-shell powders can be prepared by a chemical sintering method involving 

an inert core such as silica. We have used this approach, as reported in detail in Chapter 4 

and Chapter 5.   
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            Figure 3.2: TEM images of ST-4x catalyst after calcination at 600°C [56]. 

 

3.2 Porosity and pore size distribution  

The typical nanostructured titania film in a dye sensitized solar cell consists of a 

large network of interconnected particles about 20 nm in diameter. The film porosity is 

typically in the range of 50-65%, showing that pores can constitute more than half of the 

volume of the film – though having the porosity is critically important for placement of 

the dye and for interconnecting the system with the iodide electrolyte.  

 

3.2.1 Porosity: 

 

To obtain the optimum porosity in a chemically sintered film containing P25 and 

smaller titania particles (such as those obtained by hydrothermal processing) Li et al. [57] 

designed a binary graded structure by theoretical calculation. In their calculation, they 

consider the volume of the film as unity; and the porosity of P25 particles and the small 

particles (with a particle diameter of 12 nm) as ε1 and ε2, respectively. Assuming that the 

small particles would exist in the voids between P25 particles, the overall porosity of the 
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graded film is ε1ε2. When the volume fraction of P25 particles is set as φ1 and that of the 

small particles as φ2 (φ1 + φ2 = 1), we get φ1= (1- ε1)/(1- ε1ε2). To simplify the calculation 

it was assumed that ε1=ε2= ε. This then simplifies the volume fractions to φ1=1/(1+ ε) and 

φ2= ε/(1+ ε). 

To identify the range of ε, two pileup modes for particles was considered, cubic and 

tetrahedral pileup modes which represent the highest and lowest ε for regular packing of 

uniform spheres. The schematic for these two packing modes is shown in Figure 3.3.  

 

 

 

 

 

 

 

 

 

Figure 3.3: Schematic of the particle pileup modes: Oi (i=1-3) represents particle centers 

and D represents particle diameter [57]. 

 

The porosity for the cubic mode of packing is 0.4764 and that for the tetrahedral 

mode is 0.2595 [58]. Substituting these values into φ2 would give φ2=32% when 

ε=0.4764 and φ2=20.5% when ε=0.2595. Li et al. [57] conclude that the optimum ε 

should be in the range between 0.2595 and 0.4764 and the optimum volume fraction of 
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the small particles should be in the range between 20.5% and 32%. Since the density of 

the two kinds of TiO2 particles can be regarded as the same, the optimum weight content 

of the small particles is also in the range between 20.5% and 32%. Experimentally the 

optimum weight content of the small particles was found to be 28.5% for maximum 

DSSC efficiency [57]. This value is consistent with our experiments where the 25wt% 

TTIP sample was our best, as described above in section 2.3.3. 

 

3.2.2 Pore size distribution: 

In a low temperature chemical sintering process such as the one being discussed, 

two significant processes are happening simultaneously: 

a. The redistribution of the reactive solution within the microstructure due to 

surface tension factors and 

b. Reaction of the precursor (hydrothermal process) to give the desired product 

(titania) 

The redistribution of the liquid phase around the host particles (say P25) 

determines to a large extent the final pore size distribution in the layer. Figure 3.4 [59] 

shows the different stages in the filling of interstices in a 2-D array of circular particles 

with a liquid. As the volume of liquid is increased, first the filling of isolated necks 

happens and then the filling of pores occurs. In the regime where the liquid is situated 

only at isolated necks, there is a driving force to redistribute an inhomogeneous 

distribution of liquid homogeneously because the curvature of the contact points (neck 

regions) between the spheres is very high [59]. The liquid phase can distribute itself in 

one of three ways as indicated in Figure 3.5.  
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Figure 3.4: Different stages in filling of interstices in two-dimensional array of circular 

particles with liquid; (A) filling of isolated necks and (B) filling of pores [59]. 

 

 

 

 

 

 

 

 



 

 

54 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.5: Possible equilibrium configurations that can be adopted by liquid in close-

packed array of particles; (A) isolated necks filled with liquid (B) fraction of pores 

completely filled with liquid (pore filling shown in blue coloration) and (C) same as (B) 

but with inhomogeneous liquid distribution (pore filling shown in red coloration) [Figure 

adapted from Ref. 59]. 
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In a dye sensitized solar cell, the pore size distribution is also important. It affects 

the dye adsorption process and limits the mass transport in the redox system that 

regenerates the dye after the photoinduced electron transfer to the TiO2 . Both 

mesoporosity and macroporosity of the titania electrode have been found to be important. 

[60,61]. The TiO2 layer needs to be mesoporous (2-50 nm range of pores) to allow 

effective adsorption of dye molecules across the TiO2 surface [62,63]. The photocurrent 

output of the solar cell is directly related to the light harvesting efficiency of the dye 

which in turn depends on the amount of dye adsorbed on the surface of TiO2. The TiO2 

layer needs to be macroporous (>50nm sized pores) to allow the redox electrolyte to 

permeate into the entire structure of the TiO2 coating and be in intimate contact with the 

TiO2 nanoparticles [62,63]. 

 

3.3 Particle interconnections  

To achieve good interconnections (necking) between particles in a chemical 

sintering process with a liquid titania precursor, it is important to have the liquid wet the 

particles completely. Figure 3.6 shows the contact angles for good wetting and poor 

wetting. A low contact angle induces liquid spreading over the solid providing capillary 

attraction to bring the particles (aggregates) together. A high contact angle indicates poor 

wetting, so the liquid retreats from the solid [64] and can even push the solid particles 

apart. 

When a small amount of liquid is introduced between solid surfaces a stable 

liquid bridge can form. An effect of the capillary action of the liquid is to produce a 

resultant force between the bodies. The capillary force arising from the liquid-vapor 
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surface tension is shown in Figure 3.7. For a wetting liquid, the capillary forces pull the 

particles together and causes pore filling. Small pores fill first since they have the highest 

capillary attraction for the wetting liquid [64]. The challenge in a sintered microstructure 

is to provide an interconnected network of particles while still maintaining the desired 

porosity in the film.  

 

 

 

 

 

 

 

Figure 3.6: Wetting behavior for a liquid on a horizontal plane showing how a low 

contact angle supports wetting while a high contact angle resists wetting [64]. 

 

 

 

 

 

 

 

Figure 3.7: Schematic of two spheres of size D1 and D2 with a connecting liquid bridge – 

d is the interparticle distance [64]. 
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In chapters 4 and 5, we will discuss all the above factors using silica as a host 

material. In chapter 4 we will discuss the effect of silica particle morphology, surface 

area and pore structure on the performance of dye sensitized solar cells in silica-titania 

core-shell type structures. In chapter 5 we will probe deeper into the silica-titania 

microstructure in order to better understand the process of formation of interconnections 

in a chemical sintering process. 
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Chapter 4. Silica-titania multilayers prepared using silica particles and titanium 

alkoxide 

 

In this chapter, the preparation and characterization of silica-titania DSSC 

microstructures is discussed. In the P25:TTIP system described in Chapter 2, it is difficult 

to distinguish what part of the microstructure came from the initially crystalline P25 

titania and that which has formed from the TTIP. Both titania sources are very similar in 

the SEM or XRD because of lack of clear contrast between the commercial P25 and the 

hydrothermally formed material. In order to understand the formation of particle 

interconnections due to the hydrothermal treatment of the titanium alkoxide, we have 

designed model experiments where we substituted the P25 commercial nanopowder with 

monosized silica spheres. Silica was chosen because it is inert under the experimental 

conditions of this study. Initially, 500 nm size spherical silica particles were used to 

enable easy identification of titania formed by reaction of the TTIP. Further 

experimentation was performed with silica particles of different sizes and morphologies 

to understand the effect of the solid matrix particle morphology on the placement of the 

reacted material and the performance of dye sensitized solar cells that are formed.  

Figure 4.1 shows a schematic of a dye sensitized solar cell with a pure titania 

based DSSC and a silica-titania based DSSC. The silica particle framework of the 

composite electrode provides an additional process variable that can help deliver an 

increased surface area of titania for dye attachment and can reduce the amount of titania 

required as compared to the conventional titania-based electrodes. In addition, if the 

titania has good coverage of the silica skeleton, then the conduction pathway to the 

transparent front electrode may be well interconnected and allow for good current 

harvesting. 



 

 

59 

 

 

 

 

 

 

 

 

 

 

 Figure 4.1: Schematic of a titania based DSSC and a silica-titania based DSSC. 

 

4.1 Preparation of silica-titania powders and multilayers 

TTIP and ethanol were purchased from Sigma-Aldrich. The substrates used for 

the experiments were FTO coated glass (10<R<20Ω/sq) obtained from Flexitec 

Eletrônica Orgânica Ltda. Silica particles of various sizes and morphologies were 

purchased from Alfa Aesar. Ruthenium-535 bis TBA dye and sealing material (SX1170-

25) for dye sensitized solar cell assembly were obtained from Solaronix SA. Chemicals 

used for the electrolyte, namely LiI, I2, acetonitrile, 3-methoxypropionitrile and 4-tertiary 

butyl pyridine, were purchased from Sigma-Aldrich. 

A 1M solution of titanium tetraisopropoxide (TTIP) in ethanol was prepared. A 

well-mixed dispersion of silica particles in 1M titanium isopropoxide solution was 

prepared in the desired weight ratio (i.e. for a weight ratio of 1:9 of silica:TTIP; 0.4g of 
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silica powder is added to 3.6g of 1M TTIP solution)
5
. Initially 500 nm mono-sized silica 

particles were used. There should be minimal amount of TTIP exposure to the 

atmosphere during the preparation of this dispersion to prevent hydrolysis of TTIP. Blade 

coating is performed by placing a few drops of the dispersion on the FTO glass slide and 

using a sharp blade to spread the dispersion onto the glass slide. This process can be 

repeated depending on the desired thickness of the films. The substrates were placed on a 

Petri dish and exposed to steam by suspending them on a beaker containing 

approximately 50 mL DI water. The hotplate was set to 130 °C to boil the water and 

provide a steam treatment to the coating. This treatment was carried out for 2 hours. It is 

believed that the steam treatment helps with the hydrolysis of the precursor probably due 

to the large availability of „OH‟ groups for reaction. The possible reaction steps have 

been elucidated in Chapter 2. (Section 2.2.3: Chemistry and Mechanism). Upon 

condensation, the Ti-monomers are converted to TiO2 at the grain boundaries creating the 

necking of the particles [41]. At the end of this process, the samples were removed and 

heated in air at 500 °C for 30 minutes, to completely convert any amorphous titania 

formed to its crystalline phase. The microstructure of the coatings was analyzed using the 

SEM. To determine the crystalline phase of titania by XRD and to obtain specific surface 

area, silica-titania powders were prepared by subjecting the silica-TTIP dispersion to the 

same heating/chemical schedule. Although the broader focus of this study is in low 

temperature chemical processing methods to make titania interconnections, higher 

sintering temperatures were used to get crystalline titania. 

 

 

                                                 
5
 This translates to an expected silica:titania volume ratio of 2.7:1.0. 
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4.2 Characterization of silica-titania powders and multilayers 

4.2.1 Physical characterization (Morphology, phase and surface area) 

The thickness of the silica-titania layers was determined using a Tencor Alphastep 

200 profilometer. Scanning electron microscope (GEMINI ZEISS FESEM) with an 

Everhart-Thornley detector was used to study morphology of nanoparticle structures and 

interconnections. All samples were coated with a thin layer of gold using a sputter 

deposition system. X-ray diffraction using a Siemens Kristalloflex diffractometer with a 

Cu Kα source at 40 kV and 30 mA was used to study composition and crystallinity of the 

silica-titania materials. The specific surface area of the powders was obtained using a 

Micromeritics Gemini 2375 BET surface area analyzer.  

The SEM images of the silica-titania multilayers for high and low magnification 

is shown in Figure 4.2. The formation of a chain of interconnected silica particles bound 

together by the titania is clearly seen. The titania formed by the hydrolysis of titanium 

isopropoxide and further oxidation serves to form interconnections between the silica 

particles leading to neck region bridges between the silica particles. The smooth surface 

shapes near the necks suggest that the titania wets the silica surface well. Also, the lack of 

compositional contrast in this image supports the conclusion that titania has covered the 

silica particles well.   

To confirm that the interconnections (necking) are indeed the result of titania 

formation, we looked at a silica layer that was prepared exactly as described in section 

4.1 except that no TTIP (titania precursor) was used in the solution. The SEM images of 

these pure silica layers are shown in Figure 4.3. As can be seen from this figure, no long 

range connectivity is observed thus confirming that the titania formed from the steam 
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treatment/heat treatment process serves to connect the silica to each other. For the silica-

titania layer to be used as an anode in a DSSC, it is required that the long range 

connectivity provided by the titania extends throughout the silica-titania layer so that 

electron conduction to the FTO substrate can occur. To confirm this we looked at cross-

sectional SEM of the silica-titania layers. Figure 4.4 depicts the cross sectional images. It 

can be seen that the necking is continuous throughout the thickness of the coating 

reaching down to the FTO coated substrate. 
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                       Figure 4.2: SEM images of silica-titania layers.  
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     Figure 4.3: SEM images of silica layers. 
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              Figure 4.4: Cross-sectional SEM of a silica-titania layer. 

 

The necking of silica particles with titania has also been observed by other 

research groups. Hanprasopwattana et al. [65] used Stober silica spheres and titanium 

butoxide for their coatings. They report that the ratio of titanium butoxide to water and 

the dilution of the reactant mixture in ethanol control the nature of the coatings. If the 

alkoxide concentration is too high, precipitation of second phase titania particles occurs 

Glass substrate 

FTO layer 
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rather than a uniform coating. A higher water concentration led to aggregated spheres 

being connected with titania necks. Isolated silica spheres with uniform coatings of 

titania were obtained when the alkoxide concentration is kept low. 

Khalil et al. [66] prepared silica-titania materials via hydrolyzation of titanium 

tetra-isopropoxide in a sol of spherical silica particles (Stober particles), followed by 

drying and calcination of the xerogels at 400 and 600 ˚C. Although they report that some 

titania particles were aggregating between the spherical silica particles, the necking 

patterns similar to that shown in Figure 4.2 of this paper were not observed. Instead they 

observed that the materials consist of a composite of two distinct phases, a spherical 

silica particles matrix and titania particles between or on the surface of the silica 

particles.  

Fu and Qutubuddin [67] prepared silica-titania by controlled hydrolysis of 

titanium n-butoxide on monodisperse spherical silica particles also prepared by Stober 

method. Isolated silica particles with uniform titania nanocoating were obtained by the 

reaction of butoxide and water at ambient temperature. Higher loadings of titanium 

butoxide caused necking between silica particles and formation of second phase titania 

particles.  

Thus the formation of interconnections or necking in the silica-titania materials 

depends on several factors such as concentration of alkoxide, processing temperature and 

method of preparation of the silica-titania films. 

The crystalline phase of the silica-titania powders was obtained by XRD. Since 

the silica particles are amorphous, XRD characterization would indicate the phase of 

titania obtained by this method. The XRD pattern of this powder (Figure 4.5) shows the 
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presence of 100% anatase titania in the powder. The aluminum peaks seen in Figure 4.5 

are from the Al sample holder.  

 

 

 

 

                                      Figure 3.1 XRD of silica-titania powder 

 

 

 

 

 

 

 

 

Figure 4.5: XRD of silica-titania powder. 

 

 

To determine the powder composition and crystallinity at milder sintering 

conditions, XRD was performed on silica-titania powders that were prepared as described 

in section 4.1 but sintered at lower temperatures (200 °C, 300 °C and 400 °C) for 30 

minutes. The XRD patterns obtained are shown in Figure 4.6. At 200 °C, there is no peak 

seen and the powder mostly consists of products of incomplete hydrolysis/reaction: 

visually the powder is light brown in color. The powders sintered at 300 °C look light 

grayish and seem to have a lot of crystallized powder although some amorphous material 

still exists. Complete crystallization seems to occur at 400 °C, resulting in a pure white 

powder. The XRD pattern obtained at 400 °C is consistent with other literature reports 

[68-70].  
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Figure 4.6: XRD of silica-titania powders obtained for sintering temperatures of 200, 

300 and 400 °C (top to bottom). 
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4.2.2 Electrical characterization (I-V DSSC data) 

The silica-titania layers prepared by the steam treatment and heat treatment 

process described in section 4.1 were then soaked in a ruthenium based dye solution for 

12 hours. The dye is a solution of 0.21 mM ruthenium 535-bis TBA (commonly called 

„N719‟; chemical formula: cis-bis (isothiocyanato)bis(2,2'-bipyridyl-4,4'-dicarboxylato)-

ruthenium(II)bis-tetrabutyl-ammonium) in ethanol. The coated glass slides were removed 

from the dye solution, rinsed with ethanol and dried in air and used as the anode. 

Platinum sputtered on FTO (fluorine-doped tin oxide) coated glass was used as the 

cathode. The electrodes were assembled using a 25 μm thick thermoplastic hotmelt 

sealing foil (Solaronix SA). The assembled cells were heat treated at 105 °C for 20 

minutes to melt the sealant and thereby seal the electrodes together. The electrolyte was 

injected into the gap between the electrodes by capillary action and the edges were sealed 

with a polymer hotmelt. The electrolyte had the following composition: 0.5M LiI, 0.05M 

I2, 0.05M 4-tertiary butyl pyridine in 5ml each of acetonitrile and 3-methoxypropionitrile 

(total solvent volume is 10 mL). The cells were tested using an Oriel Solar Simulator 

(equipped with AM 1.5 filter) for an input power of 90 mW/cm
2
.  

The I-V curve obtained for this cell is shown in Figure 4.7. The Voc, Isc and fill 

factor of the cell were 0.6V, 2.47 mA/cm
2
 and 0.52 respectively. The solar cell efficiency 

was 0.86%. The low efficiency of the cell is attributed to the lower amounts of titania in 

the silica-titania layer which leads to low dye adsorption. It is expected that the efficiency 

of silica-titania will increase if the ratio of TTIP to silica is increased. The morphology 

and porosity of the silica particle also play a role – this is explained further in section 

4.2.3. 
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 Figure 4.7: I-V curve of a silica-titania based dye sensitized solar cell.  

 

 

4.2.3 The Importance of silica morphology in the performance of silica-titania DSSC 

 

To observe the effect of silica particle structure on the performance of the silica-

titania based DSSCs; we have used silica particles of different sizes and morphologies. 

Initially, we started off with 500 nm spherical silica particles. Since the efficiencies with 

the 500 nm silica particles was only around 0.86% we decided to use smaller silica 

particles with the expectation that the smaller silica particles would be able to support 

more titania and provide an increased surface area of the titania. The silica powders had a 

particle size of 500 nm, 20 nm and 80 nm respectively (data provided by Alfa Aesar). 

Silica-titania layers using the three silica powders were prepared as described in 

section 4.1. Characterization was performed using SEM and BET and the layers were 

tested in DSSCs using the method described in section 4.2.1 and 4.2.2. 
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Figures 4.8, 4.9 and 4.10 are SEM images of silica-titania layers obtained using 

each of the silica powders. The silica-titania coating prepared using the 500 nm spherical 

particles (Figure 4.8) look like connected chains of particles while the coatings prepared 

using the 20 nm and 80 nm particles seem to be more aggregated with little long-range 

connectivity between the aggregates. As illustrated in Figure 4.1, a continuous chain of 

titania is essential for good electron conduction pathways and the morphology of the 500 

nm silica based electrode has the best connectivity between particles in this respect.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.8: SEM image of a silica-titania layer prepared using 500 nm silica spheres. 
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   Figure 4.9: SEM image of a silica-titania layer prepared using 20 nm silica particles. 
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Figure 4.10: SEM image of a silica-titania layer prepared using 80 nm silica particles. 

 

 

 

Table 4.1 shows the results of BET specific surface area measurements for the 

three silica-titania composites. In Table 4.1, the first column indicates the particle size 

and the second column is the specific surface area data provided by the vendor. The third 

column is the ideal specific surface area if the silica particles were perfectly spherical. 

The ideal specific surface area for each particle size is calculated using the formula 

                                           S = 3 / (ρ*R)  

where S is the specific surface area of the material, ρ is the density and R is the particle 

radius. The value of ρ used for calculating S is 2.2 g/cc. 
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Table 4.1: BET specific surface areas of silica-titania powders 

 

 

The powders prepared using the 500 nm silica particles have a tremendous 

increase in specific surface area when titania is added, suggesting that the titania layer 

formed from the alkoxide leads to a higher surface area material. The powder prepared 

with the 20 nm silica particles also shows a significant increase in specific surface area; 

suggesting that the increase is due to the formation of high surface area titania particles. 

For the powder prepared with the 80 nm silica particles we first notice that the ideal 

spherical surface area is much smaller than the actual starting sample, suggesting that the 

80 nm particles are actually porous and might be built from aggregates of much smaller 

primary particles. The specific surface area of the silica-titania powders prepared with the 

80 nm silica actually decreases most probably due to some kind of pore-filling 

mechanism. This can also be observed by looking at the SEM image of the silica-titania 

layer prepared with the 80 nm silica particles. The morphology of the layer is very 

spongy suggesting that the 80 nm silica particles themselves are very porous. When the 

titania is added, we believe the titania solution has been drawn into the tiny scale pore 
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77 

 

20 160 
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80 400 

 

34 

 

179 
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structure much the way a sponge absorbs fluid. Thus, the titania is filling many of these 

pores causing the observed reduction in specific surface area. 

 Dye sensitized solar cells were prepared and tested for silica-titania layers of the 

three different silica particle sizes and morphologies. The thickness of the silica-titania 

coating was maintained in the range of 14-18 μm for all three sample types. The results of 

the DSSC testing are shown in Table 4.2.  

 

Table 4.2: Photovoltaic parameters of DSSC cells prepared with 3 different types of 

silica particles 

 

 

 

 

 

 

 

 

 The silica-titania samples prepared using the 500 nm silica particles gave the 

highest efficiency, though still lower than found in pure titania DSSCs. Initially we 

expected that the smaller silica particles with high surface areas would lead to higher 

efficiencies (by allowing for greater dye loading) but the actual trend goes in the opposite 

direction. This could be explained from the SEM images (Figures 4.8, 4.9 and 4.10) and 

BET data (Table 4.1). The primary causes for poor efficiencies of DSSCs prepared using 

the smaller (20 nm and 80 nm) silica particles appears to be poorer intergranular 

connections and pore filling by the resultant titania material.  
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4.3 Results and Discussion 

The 500 nm silica particles are non-porous and have very low starting surface 

area (2-6 m
2
/g). After the formation of titania coatings within these composites, we find 

nice chains of interconnected particles with the titania around the silica particles being 

well connected to each other. There is also a substantial increase in specific surface area 

that makes available a larger amount of titania surface for dye attachment and electron 

conduction. This is supported by the higher short circuit current and higher efficiency 

found in these dye sensitized solar cells.  

The coatings prepared with 20 nm and 80 nm silica particles show irregular-

shaped aggregates that are not well connected to each other. Although the titania has the 

same chemical synthesis route in all cases, its interaction with the existing silica particles 

in these two cases results in microstructures that deliver much lower short circuit currents 

and lower efficiency of DSSCs.  

The 80 nm silica particles have negligible DSSC efficiency. There is a significant 

reduction in the specific surface area and it is apparent that most of the titania has 

penetrated into the pores and thus not been available for dye attachment and further 

electron conduction. The morphology, surface area and porosity of the silica particles 

play a crucial role in controlling the nature of the interparticle connections and the 

performance of the silica-titania based dye sensitized solar cells. It is desirable to have 

non-porous silica particles of spherical morphology to begin with and then form a titania 

layer to obtain a higher surface area with good electron conductivity. It is notable that the 

titania created in case 1 (silica 500 nm) causes a significant increase in the surface area, 

suggesting that it is not just forming a continuous smooth coating on the surface of the 
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spheres. Instead, it seems like the hydrolysis and condensation of the TTIP leads to 

deposition of material that is itself somewhat porous or perhaps nanoparticulate in nature, 

which is advantageous for DSSC operation. 

It is useful to consider how the titania solution interacts with the different samples 

during drying and steam treatment, when most of the final coating morphology is 

established. In addition to the certainty that the titania solution is drawn preferentially 

into the smallest pores provided by the silica network, it is likely that the capillary forces 

that this solution experiences during drying and steam treatment can cause imbalances 

where clumps of particles densify locally, but in the process they also may pull away 

from their neighbors and give a lower level of long range interconnectivity. This effect 

was seen most dramatically in the 80 nm silica source material.  

The findings of this study have useful implications for any chemical sintering 

process. In particular, these results could be useful for the low temperature P25-

hydrothermal titania process discussed in Chapter 2. This research suggests that instead 

of using P25 nanoparticles we may be able to improve the efficiencies of the low 

temperature chemically sintered titania electrode by using larger spherical titania particles 

and forming a thin high surface area titania superstructure on it by hydrothermal 

treatments. 
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Chapter 5. Silica-titania sub-monolayers: microstructural characterization and 

image analysis 

 

In Chapter 4, we discussed the preparation of silica-titania multilayers and the 

effect of the morphology of the silica particles on the performance of dye sensitized solar 

cells. SEM and BET analysis and efficiency data of dye sensitized solar cells suggested 

that to obtain a good interconnected structure in the electrode it would be beneficial to 

have spherical host particles with a thin coating of titania.  

To probe deeper into the interconnections in the silica-titania layer – specifically 

the development of interparticle neck contacts -- we conducted a set of studies using 

single layers of silica-titania deposited on a substrate. This was performed to line up the 

neck regions for microscopic observation. The preparation of such sub-monolayers and 

the study of interconnections at a particle-particle level is the focus of this chapter.  

 

5.1 Background 

Self assembled monolayers of particles have been studied extensively due to the 

wide range of applications [71-73]. While monolayers of a single material (oxide or 

polymer) have been studied widely, to the best of our knowledge, monolayers or sub-

monolayers of multi-oxide materials have not been studied to date. Examining the silica-

titania submonolayers is therefore an opportunity to study the necking process at the 

particle-particle level.  

Figure 5.1 illustrates a schematic picture of the process of the particle film 

formation of a monolayer [74]. In the early stage of the process, the particles can move 
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freely in the liquid film. As evaporation proceeds, oligomer-like deformable loose 

aggregates partially form in the liquid film, regardless of the particle concentration of the 

applied suspension, and the upper part of the aggregates protrudes from the liquid layer. 

The particles in the upper part of the aggregates that have protruded are drawn down by 

gravitation and capillary immersion force, excluding the underlying particles aside (a). 

Before the particles reach the substrate below, some of the underlying particles at the 

bottom protrude from the liquid surface, which are dragged laterally by capillary 

immersion force (b). 

Therefore lateral and longitudinal movements of the particles occur coincidentally 

to organize the particle monolayer during the final stage of the process. The organization 

stops when all the dispersion medium evaporates (c)[74]. 

 

 

 

 

 

 

 

 

 

 

Figure 5.1: Feasible process of the particle film formation; (a) top part of the transient 

aggregate is drawn downward, (b) longitudinal and lateral particle movements occur 

coincidentally to organize the particle film and (c) all the dispersion medium evaporates 

and organization stops. [74]. 
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Most of the techniques used to assemble highly packed monolayers of colloidal 

particles involve the convective assembling of particles, such as the dip coating method 

[75-77]. In these methods the substrate is immersed in a colloidal solution and withdrawn 

vertically or with an angle of inclination at a certain velocity. Another commonly used 

method is the Langmuir–Blodgett (LB) technique [78–80]. This method is frequently 

used to prepare monolayers when the target particles have an affinity for the air/water or 

air/oil interface. The particles are deposited on a liquid film and then compressed by 

mechanical barriers, then assembled on a substrate by dipping the formed monolayer. 

Other methods for fabricating particle monolayers, such as the drop coating method [81] 

and electrophoretic deposition [82] have been reported. 

Some of the disadvantages of the above methods include the relatively slow time 

for the fabrication of a monolayer film, the small area of coating and the non-uniformity 

of the final monolayer. For a monolayer fabrication technique to be industrially applied, 

it must be fast, low-cost and must permit a large area (larger than Ø 2 in.) of uniform 

monolayers to be assembled with high surface coverage. Spin coating method is one such 

technique that has potential for industrial applications [83]. 

In sections 5.1.1 and 5.1.2 we provide a background on the particle rearrangement 

by spin coating and the interparticle neck formation which is related to the formation of 

pendular liquid bridges between spherical particles.  

 

5.1.1 Formation of sub-monolayers by spin coating  

The hydrodynamics involved in the spin coating process have been investigated 

by various authors [84-85]. During the initial stages of spinning, the thinning is mainly 
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due to the viscous effects. The centrifugal outflow is more dominant and since the 

particles are immersed in the solvent, they move around in response to the convective 

outflow. At a stage in the spin coating process, the convective effect and the simultaneous 

solvent evaporation are approximately equal in magnitude. This occurs at fluid depths on 

the order of only a few microns. Beyond this point more thinning occurs by solvent 

evaporation than by viscous outflow. As the solvent evaporates, the concentration of the 

particles rises forcing more interparticle interactions to take place [86].  

Ogi et. al. [83] investigated the effects of the concentration of SiO2 particles, the 

ambient temperature and the relative humidity as well as the spin speed on the surface 

coverage and the uniformity of monolayers of silica spheres on a sapphire substrate. 

Aqueous suspensions of silica particles were spin coated onto sapphire substrates in a 2-

step spin coating process. Figures 5.2 and 5.3 [83] illustrates the effect of solvent 

evaporation rate and spin speed on the spin coating process. 
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Figure 5.2: Illustration of the effect of solvent evaporation rate on the assembling of 

particles in a spin coating process [83]. 

 

The rate of evaporation of solvent is an important factor in controlling the 

formation of a particle monolayer during spin coating. When the relative humidity is high 

(60% RH), the flux of water from the solution to air decreased considerably, and the 

evaporation process is retarded so that the particles were assembled in an orderly manner 

by capillary forces. When the relative humidity was changed from 60 to 30%, the number 

of particles in island-like arrays increased and the surface coverage decreased 

significantly. This is because the moisture content surrounding the substrate decreased 

and the water flux increases, thus accelerating the evaporation process before capillary 

forces became dominant, resulting in island-like assembling of the particles. 

It is well known that the regulation of the spin speed is an important parameter in 

obtaining a uniform coating over large area. Figure 5.3 is an illustration of the forces at 

play for different spin speeds.  
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Figure 5.3: Illustration of effect of spin speed on the assembly of particles during spin 

coating [83]. 

At lower spin speeds (~100 rpm), the solution height is higher and because of low 

evaporation of solvent and low centrifugal force, the particle flux toward the edge of the 

substrate is also low, resulting in a multilayer array in the center and low surface 

coverage in the radial direction. If the spin speed is too high (~1000 rpm) the centrifugal 

forces are initially too strong and the evaporation of solvent so fast that a large number of 

particles are expelled from the substrate and a bilayer array is formed in the substrate 

center. An optimum spin speed is necessary to get monolayer coverage on the substrate.   
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In the next section (Section 5.1.2) we will discuss the process of formation of the 

interparticle necks by explaining the theory of liquid bridges. 

5.1.2 Formation of interparticle necks (Pendular liquid bridges) 

When liquid is introduced between two spherical particles, it could lead to the 

development of a stable liquid bridge which produces a resultant attractive force between 

the two particles. This arises from a pressure deficiency in the bulk of the liquid (the 

capillary force) and from the surface tension of the liquid acting on the two bodies [87]. 

The contact between the three phases, solid, liquid, and gas, induces the onset of forces 

between these particles, which will depend on physical-chemical aspects like the 

wettability of the particles, the geometry of the meniscus as well as the particles‟ sizes 

and the separation between them [88]. 

Megias-Alguacil and Gauckler [88] have presented the conditions for the 

formation of pendular liquid bridges between spherical bodies. Figure 5.4 [88] shows a 

sketch of a liquid bridge geometry. In this figure, R is the solid particle‟s radius, xa and ya 

are the abscissa and coordinate of the contact point between the solid and liquid profile, 

respectively,  is the half-filling angle, Ө is the wetting angle, ρ and L are the principal 

radius of the liquid meniscus, measured orthogonally, H is the surface-to-surface distance 

between the solid particles, and d is the wetted portion of each hemisphere. The reference 

system is chosen such that its origin is the middle point between the spheres and the x-

axis lies along the straight line which joins the particles‟ centers, as shown in Figure 5.4.  
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Figure 5.4: Sketch of a liquid bridge geometry [88]. 

 

The liquid volume of the bridge, V, may be determined for a given distance 

between particles, H, by definite integration of both the solid and liquid profiles [88] and 

substitution of relations for the solid and liquid profiles as is shown in figure 5.5. The 

liquid bridge profiles for varying H/R ratios, wetting angles and relative volumes were 

derived and are shown in figure 5.6.  
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Figure 5.5: Equations used to calculate volume of a liquid bridge [88]. 

 

 

 

 

 

 

 

 

 

 

Figure 5.6: Liquid bridge profiles for various parameter values [88]. 
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The following phenomena can be observed from figure 5.6. The overall effect of 

separating the particles while keeping the liquid volume constant is an elongation of the 

bridge, which becomes longer and thinner and less concave. Also, the curvature of the 

liquid bridge decreases as the wetting angle is increased. And finally, increasing the 

liquid volume causes a thicker meniscus (larger L) as well as an evident reduction of the 

meniscus curvature (larger ρ). If the amount of liquid is increased sufficiently, it may 

completely cover the spheres, and beyond this point, the spheres will be fully immersed 

in the liquid; this situation clearly does not correspond to a liquid bridge anymore. In 

other words, the bridge may no longer exist under this circumstance [88]. 

The formation of liquid bridges in a liquid phase sintering process can lead to 

interparticle necks between the host particles after reaction and heat treatment. From 

section 5.1.2, we can see that the wetting angle and the concentration of liquid precursor 

can have an effect on the liquid bridge profiles and thus on the neck formation. In the 

following sections we will discuss the preparation and characterization of silica-titania 

sub-monolayers with emphasis on the formation of interparticle necks and quantification 

of neck widths. Because of the geometry created and the net attractive forces of these 

pendular bridges then we are always looking at samples where the two spheres touch. 

This is essentially the special case of H=0 for Megias-Alguacil and Gauckler‟s treatment 

[88]. 
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5.2 Preparation of silica-titania sub-monolayers 

5.2.1 Materials and Methods 

Titanium (IV) isopropoxide (97% assay) was purchased from Sigma-Aldrich. 

Ethanol (ACS reagent, >99.5% assay) and 1-butanol (99.9%) were obtained from Sigma-

Aldrich and used without further purification. Glacial acetic acid was purchased from 

ACROs Organics. Silica powder (500 nm) was purchased from Alfa Aesar. The plain 

glass slides that were used as substrates were obtained from Fisher Scientific.  

A sol of titanium isopropoxide (varying amounts) was prepared using 0.625mL 

acetic acid and 9.5 mL of 1-butanol. To this, 0.1g of silica powder was added. The silica 

powder used for preparation of the sub-monolayers consisted of 500 nm spheres. After 

stirring for 30 minutes, the solution was spin coated onto glass samples. The glass 

samples were of the size of 0.25” X 0.25” and were cut from 1mm thick plain glass 

slides. The glass slide pieces were cleaned with ethanol and dried thoroughly prior to 

deposition. 

The spin coater used is a Specialty Coating Systems model P6700 coater shown in 

Figure 5.7. A few drops (10-12 drops) of the prepared solution are placed onto the 

microscope slide piece that is adhered to the coater chuck. The spin speed used is 3000 

rpm for 40 seconds. At the end of the coating process, the samples are air dried and 

further heat treated at 500 °C for 30 minutes.  

 

5.3 Characterization of silica-titania sub-monolayers 

 

 

 After heat treatment the slides were coated with a thin layer (10-20 nm) of iridium 

to make the samples conductive. The iridium coating was performed using a Gatan model 
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681 ion beam coater; the coating thickness is approximately 10 nm. A picture of the 

Gatan ion beam coater used for coating the submonolayers is shown in Figure 5.8. 

Scanning electron microscope (GEMINI ZEISS FESEM) with an Everhart-Thornley 

detector was used to study morphology of the sub-monolayer structures. Image analysis 

was performed on the SEM images using Image J (ImageJ 1.42q; National Institutes of 

Health, USA). Atomic force microscopy (AFM) was used to look at surface topography 

and test another means for measuring the size of the neck between silica particles. AFM 

was performed with a Nanoscope IV (Digital Instruments) in contact mode on 10 x 10 

micron area of the sample. HRTEM (High Resolution Transmission Electron 

Microscope) micrographs were obtained at 200keV in a JEOL 2010F TEM/STEM 

equipped with Gatan Imaging Filter (GIF) operating in STEM-mode.  
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           Figure 5.7: SCS P6700 model Spin coater. 
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               Figure 5.8: Gatan ion beam coater.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

92 

5.4 Results and Discussion 

 

5.4.1 Morphology of the silica-titania sub-monolayers (SE detector) 

The sub-monolayers of silica-titania were prepared for 7 different amounts of the 

titanium alkoxide precursor. The amounts of titanium isopropoxide precursor used were 

0.75, 0.375, 0.25, 0.125, 0.0625, 0.03125 and 0.015625mL. Initially, we started with the 

0.75 mL TTIP concentration to test the possibility of getting sub-monolayer coverage. 

Once that was achieved, the amount of TTIP was reduced for successive samples because 

the goal of the experiments was to observe the neck regions but aim for very low surface 

coverage of titania. For this reason, the amounts of TTIP are indicated in reverse order in 

the figures and table in this chapter. 

The secondary electron (SE) detector of the SEM is used to obtain topographic 

information The SEM images of the sub-monolayers obtained using the secondary 

electron (SE) detector for 4 of the ratios of TTIP used are shown in Figures 5.9 and 5.10 

for low and high magnification values. The images show that the silica particles are 

joined together in pairs, triplets and short chains by the titania. In the high magnification 

Figures of 5.10 we can more clearly see the silica particles joined at the neck by the 

titania formed by the hydrolysis of the alkoxide and subsequent heat treatment. The 

smooth surface shapes near the necks suggest that the titanium alkoxide precursor sol 

wets the silica surface well during the spin coating process. 

XRD studies conducted previously on silica titania multilayers (section 4.2.1) 

have shown that the necks are composed of crystalline anatase titania. 
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Figure 5.9: SEM images (magnification 20KX) of silica-titania sub-monolayers for 4 

different titania precursor amounts (a) 0.75mL (b) 0.25mL (c) 0.0625mL and (d) 

0.0156mL. 
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Figure 5.10: SEM images (magnification 150Kx) of silica-titania sub-monolayers for 4 

different titania precursor amounts (a) 0.75mL (b) 0.25mL (c) 0.0625mL and  

(d) 0.0156mL. 
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To confirm that the neck region is indeed formed by the titania that came from the 

alkoxide precursor we prepared pure silica layers by spin coating a solution of the 500 

nm silica powder in acetic acid and 1-butanol followed by post heat treatment at 500°C 

for 30 minutes. This procedure is exactly the same as described in section 5.2.1 except 

that no titanium alkoxide is used in the sol recipe. The SEM image of the sample 

prepared with no titania precursor is shown in Figure 5.11. In this image, some individual 

silica particles and some groups of silica particles can be observed. The absence of 

necking can be seen more clearly in Figure 5.12 where the SEM images of a silica-titania 

and silica layer have been placed side by side. In the case of the pure silica layer, the 

silica particles are just touching each other and it looks like the particles have come 

together most likely due to capillary forces [83,89]; no necking phenomenon is observed 

in this case which fits well with our observation that in solutions containing the titanium 

isopropoxide precursor, the titania formed is creating necking between the silica particles.  
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Figure 5.11: SEM image of a silica sub-monolayer prepared without a titania precursor. 

 

 

 

 

 

 

 

 

Figure 5.12: SEM image of silica-titania layer prepared with 0.0625mL TTIP (left) and 

pure silica layer (right). 
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5.4.2 Morphology of the silica-titania sub-monolayers (In-lens detector) 

The in-lens detector of the GEMINI FESEM was used to obtain clearer high-

contrast images of the sub-monolayers.  In the in-lens detector of the SEM, due to a 

sophisticated magnetic field at the pole piece, the secondary electrons are collected with 

high efficiency. In particular at low voltages and small working distances, images with 

high contrast can be obtained. The drying effects occurring during spin coating and the 

necking of titania were more clearly observed with the inlens detector.  

Figure 5.13 shows the SEM image of a silica-titania sub-monolayer prepared with 

0.75mL TTIP and 0.125mL TTIP: both were obtained with the in-lens detector. For the 

sample prepared with 0.75mL TTIP; the silica-titania layer seems to have cracked due to 

the drying effect of the solvent evaporation and the post treatment at 500C and this has 

led to some particle chains being broken at the necks. The same cracking effect can also 

be seen in the samples prepared with 0.125mL TTIP although the effect is less 

pronounced in this case.  
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Figure 5.13: SEM image (in-lens detector) of silica-titania sub-monolayer prepared with 

0.75mLTTIP (top) and 0.125mL TTIP (bottom). 
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Figure 5.14: SEM image (inlens detector) of silica-titania submonolayers prepared with 

0.125mL TTIP. 
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The in-lens detector images of Figure 5.14 show in more detail the chain 

formation and breakage at different magnifications. These images of silica-titania sub-

monolayers were obtained for a 0.125 mL TTIP precursor in the sol. The high 

magnification images show the breakaway points of the necks (at the top and bottom) and 

the low magnification images show the long chains of particles held together by the 

necks.  

5.4.3 Pore size distribution in the silica-titania sub-monolayers 

 Figure 5.15 shows the SEM images of silica-titania sub-monolayers prepared 

using 0.0625mL of TTIP in solution. The presence of pores of varying sizes and shapes is 

observed. The pore sizes were measured using the CARL ZEISS SmarTiff annotation 

editor (V 1.0.1.2). We can see that both mesopores and macropores are formed in the 

silica interconnected structure. This dual porosity pore structure combined with the pore 

formation within the titania itself (micropores and mesopores) shows that there is a range 

of porosity that can be obtained in these sub-monolayers. We expect similar distributions 

in pore shape and size for the three dimensional samples. 

 The pore structure is affected by several factors during deposition including 

wetting angles, ratio of silica to titania precursor, evaporation rates of solvents in the sol 

recipe, surface tension and spin coating parameters. By controlling these factors, the pore 

size distribution of the silica-titania interconnected structure can be tailored both in 

monolayered and multilayered structures. 
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Figure 5.15: SEM image (SE detector) of silica-titania sub-monolayers prepared with 

0.0625mL TTIP. 
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5.4.4 Image analysis of silica-titania sub-monolayers using ImageJ 

The SEM images obtained for different precursor concentrations were analyzed 

using image analysis software. ImageJ is a public domain Java image processing 

program. It can be used to display, edit, analyze, process, save and print 8-bit, 16-bit and 

32-bit images. It can read many image formats including TIFF, GIF, JPEG, BMP, 

DICOM, FITS and "raw". It supports “stacks", a series of images that share a single 

window. It is multithreaded, so time-consuming operations such as image file reading can 

be performed in parallel with other operations. 

It can calculate area and pixel value statistics of user-defined selections. It can 

measure distances and angles. It can create density histograms and line profile plots. It 

supports standard image processing functions such as contrast manipulation, sharpening, 

smoothing, edge detection and median filtering. 

It does geometric transformations such as scaling, rotation and flips. Image can be 

zoomed up to 32:1 and down to 1:32. All analysis and processing functions are available 

at any magnification factor. The program supports any number of windows (images) 

simultaneously, limited only by available memory. 

Spatial calibration is available to provide real world dimensional measurements in 

units such as millimeters. Density or gray scale calibration is also available in ImageJ 

[90].  

Figure 5.16 shows a snapshot of the ImageJ window with the option to adjust the 

image threshold selected (thresholding is used to automatically or interactively set lower 

and upper threshold values, segmenting grayscale images into features of interest and 

background). 
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   Figure 5.16: Snapshot of ImageJ window with Image/Adjust/Threshold option    

   selected. 
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5.4.4.1 Measuring distances in ImageJ 

ImageJ was used in this study primarily to measure distances in images (namely 

the neck diameter and 2-particle length of 2-particle silica chains). The three steps 

followed in ImageJ to calculate distances are listed here. Detailed instructions for other 

menu options in Image J are provided in Appendix B. To measure lengths in the image: 

1. Improve brightness/contrast of image if needed by selecting 

Image/Adjust/Brightness/Contrast in the menubar. 

2. To set the scale on the image, draw a straight line in the image just above the 

scale bar of the image. Select Analyze/Set Scale. In the Set Scale menu, 

enter known distance and unit of length. (refer Figure 5.17). The image 

now has the desired scale information. 

3. To measure distance, draw a line using the line tool for the point to point 

distance that needs to be measured. In the menu bar select 

Analyze/Measure. The length is displayed in the Results tab (refer Figure 

5.18) 
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     Figure 5.17: Snapshot of ImageJ with “Set Scale” function selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.18: Snapshot of ImageJ with “Results” window selected. 

 



 

 

106 

5.4.4.2 Measurement of neck width and 2-particle length 

The neck width and the 2-particle length of pairs of silica-titania structures was 

measured using ImageJ according to the procedure described in section 5.4.4.1. Figures 

5.19 and 5.20 are illustrations of a 2-particle chain with arrows showing distances 

measured for neck width and 2-particle length. 

For each titania precursor concentration studied, four particle pairs were measured 

and the average neck width and 2-particle length for these 4 particle pairs was calculated. 

The results of image analysis are tabulated in Table 5.1 and shown graphically in Figure  

5.21. The error bars in Figure 5.21 represent the measurement error in ImageJ. The 

measurement error in ImageJ for each of the 4 measurements (and hence the average 

measurement) is ±20 nm. This error is reduced when we use high magnification images; 

but we were able to see fewer 2-particle chains at higher magnifications. Therefore to get 

average measurements of four 2-particle pairs, the 20KX SEM images as shown in Figure 

5.9 were used for the ImageJ length measurements shown in Table 5.1 and Figure 5.21. 

From the data in Table 5.1, it can be seen that the neck width decreases by 43% and the 

2-particle length decreases by 15% as we reduce the titania precursor amount in the 

solution from 0.75 to 0.0156mL. This means that by decreasing the titania precursor 

amount by a factor of almost 98% the neck width has decreased by only 43% - indicating 

preferential collection of titania at the neck regions. It also shows that in the context of 

interparticle connections in a DSSC, very low amounts of titania precursor can provide 

significant particle-to-particle contact material at the neck regions.  
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Figure 5.19: Illustration of a 2-particle chain with arrows showing distances measured 

(neck width and 2-particle length). 

 

  

 

 

 

 

Figure 5.20: Illustration of 2-particle chain with silica particles shown (gray coloration) 

and with arrows showing distances measured (neck width and 2-particle length). 
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Table 5.1: Neck width and 2-particle length averaged for four 2-particle pairs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TTIP amount in sol 

(mL)   

TTIP molar 

concentration (M) 

Neck width (nm) 2-particle length 

(nm) 

0.75 0.2329 304 914 

0.375 0.1207 222 824 

0.25 0.0813 243 847 

0.125 0.0412 213 821 

0.0625 0.0207 227 818 

0.0312 0.0104 231 795 

0.0156 0.0052 173 780 
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Figure 5.21: Average neck width and average 2-particle length for varying TTIP 

concentration. 
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5.4.5 Surface topography of silica-titania sub-monolayers 

The surfaces of the silica-titania sub-monolayers were scanned with an atomic 

force microscope to obtain topography images and calculate neck depths. The AFM 

image along with the corresponding surface plot of a silica-titania sub-monolayer 

prepared with 0.0625mL TTIP is shown in Figure 5.22. The formation of silica particle 

chains is clearly seen from these images. The AFM images were analyzed with a 

sectioning tool to obtain depth information. The depth of the neck from the surface of the 

silica was obtained for the sample prepared with 0.0625mL TTIP and is shown in Figure 

5.23. It was observed that for the three TTIP amounts tested (0.25mL, 0.0625mL and 

0.0156mL), the depth of the neck from the silica surface was in the range of 80-110 nm.  
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          Figure 5.22: AFM images of a silica-titania sub-monolayer. 
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Figure 5.23: Section analysis of the AFM image of Figure 5.22 used to obtain depth 

information. 

 

5.4.6 High resolution transmission electron microscopy of silica-titania sub-

monolayers (Estimation of Surface coverage of silica) 

 

 The 2-particle lengths calculated in ImageJ (Table 5.1) can be used to estimate 

surface coverage of silica particles provided the particle size distribution of the silica is 

extremely narrow. Referring to figure 5.20, we can see that subtracting the silica particle 

sizes from the 2-particle length measurement should give us twice the titania thickness, 

provided the particles are monosized. But this is not the case for the commercial silica 
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powder used in our experiments. Although the silica particle size reported by the vendor 

is 500 nm we have observed in the SEM that many of the silica particles are actually 

closer in diameter to 400 nm (refer Figure 5.24). The sample shown in Figure 5.24 is a 

pure silica layer prepared by the procedure described in section 5.2.1 except that there 

was no titania precursor in the solution that was spin coated. The silica particle diameter 

was measured by using the CARL ZEISS SmarTiff annotation editor (V 1.0.1.2). The 

particle diameter of 4 silica particles selected at random shows the variability in particle 

size (from 390 nm to 450 nm). Due to this variability it was not possible to get an 

estimate of the surface coverage of titania by measuring the average 2-particle length of 

the particle pairs. A suitable silica particle with uniform particle sizes was not found to be 

commercially available. This combined with the lack of compositional contrast between 

silica and titania meant that the surface coverage of silica by the titania could not be 

determined by image analysis.  
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Figure 5.24: SEM image of pure silica layer showing silica particle sizes.  

 

 We have therefore used TEM (transmission electron microscopy) to determine 

surface coverage. The TEM samples were prepared from the spin coated glass samples by 

dispersing the spin-coated material in methyl alcohol and releasing a few drops of the 

liquid on an amorphous, „lacey‟ carbon film supported on copper grid. Then, the mixture 

was allowed to dry leaving behind particles dispersed on the TEM grid. HRTEM images 

obtained thus are shown in Figure 5.25. This image was obtained for a silica-titania sub-

monolayer that was prepared with 0.25mL TTIP. The image on the left shows a group of 

silica particles with titania formation also seen. The image on the right can be used to 

obtain thickness information and it shows that the titania on the surface of silica is around 
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5-7nm thick for this particular sample. This demonstrates that we can obtain extremely 

thin titania coatings on silica surfaces by the spin coating process adopted in our research. 
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Figure 5.25: HRTEM images of a silica-titania sub-monolayer. (Courtesy: Dr. Jafar Al-

Sharab, Department of Materials Science and Engineering, Rutgers, The State University 

of New Jersey). 
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5.4.7 Theory of interparticle neck formation 

 

The SEM images of Figures 5.9, 5.10, 5.13 and 5.14 demonstrate that we have 

good wetting of the silica particle by the titania sol which means that the contact angles 

are very low. If this were not the case, we would most likely see aggregates of titania 

particles and individual silica particles on the surface of the glass substrate. The titania 

sol also seems to wet the substrate well and form a thin coating on the substrate as 

evidenced in the in-lens images of Figures 5.13 and 5.14; although at the highest 

concentration (TTIP=0.75 mL) the drying effects are pronounced. As we have seen in 

Section 3.3 and Figure 3.6 good wetting is essential if we need to have silica particles that 

are well connected to each other and to the substrate. 

Based on the shapes of the interparticle necks and the relationship of the neck 

width with the amount of TTIP, we can hypothesize that the formation of interparticle 

necks begins with the formation of liquid bridges during spin coating. Further evidence of 

this can be found in the optical microscope of a spin coated silica-titania sol that was 

obtained soon after spin coating (Figure 5.26). The formation of a few silica particle 

chains is seen to emerge even for the lowest TTIP amount (0.0156mL). We believe that 

this liquid bridge upon further reaction and heat treatment at 500 °C for 30 minutes leads 

to the formation of the titania necks. 
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Figure 5.26: Optical microscope image of a spin coated layer of silica particle-titania sol 

solution (Amount of TTIP = 0.0156mL). 

 

We described in section 5.1.2 how the formation of pendular liquid bridges 

depends on the wettability of the particles, the geometry of the meniscus and the particle 

sizes. A lot of research has been published on such liquid bridges; a chronological 

summary of research investigations on pendular bridges between two particles is 

provided by Mehrotra et al. [91]. Melrose et al. [92] present the exact geometrical 

parameters for the pendular ring fluid if the contact angle and the filling angle are known. 

Table 5.2 (adapted from Ref.[92]) gives the meniscus curvature J and the confined 

volume V for a contact angle Ө and filling angle ψ. (The contact angle, Ө, is specified as 

the angle measured through the confined phase, the filling angle, ψ, is the angle between 
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the axis of cylindrical symmetry and the line of meniscus contact, and R denotes the 

sphere radius).  

 

Table 5.2: Geometrical parameters for pendular ring fluid (adapted from [92]). 

 

 

 

 

 

 

 

 

 

Since we have good wetting of the silica particles we can assume a contact angle 

of 0°. To get an approximation for the filling angle from the SEM images; we can use the 

angle measurement feature of ImageJ. From these values it is possible to get an estimate 

for the volume of the pendular bridges for different TTIP precursor concentrations.  

 

5.4.8 Estimation of TTIP concentration needed to create necking 

 

From Table 5.1, the dimensions of the neck obtained by image analysis 

can be used to back calculate the amount of TTIP needed in a 3-D electrode configuration 

where we have spherical titania host particles instead of spherical silica particles. This 

calculation is documented in Appendix C. The calculations in Appendix C show that the 
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weight ratio of host titania:TTIP that is required for a 65% porous titania electrode with 

400nm spherical titania particles is 84. Referring back to Chapter 2 (section 2.3.3.1) we 

see that the weight ratio of P25:TTIP that gave the best efficiency (DSSC 

efficiency=2.09%) is 1/0.25=4. This leads us to suggest that the amount of TTIP required 

to form interconnections would probably be much less if we used spherical titania in the 

bulk matrix instead of P25. 

If we had used 200nm spherical titania particles instead of 400nm, then 

the volume of each particle would decrease by a factor of 8, and therefore the number of 

necks increases by a factor of 8. Referring to the calculations in Appendix C we would 

see that the weight ratio of spherical titania to TTIP would decrease by a factor of 8 when 

the particle size is halved. The weight ratios and molar ratios for 5 different spherical 

particle sizes are shown in Table 5.3.  

 

Table 5.3: Weight ratio and molar ratio of Titania /TTIP for 5 spherical titania particle 

sizes 

Particle size of spherical 

titania host particle (nm) 

Weight ratio 

titania:TTIP 

Molar ratio 

titania:TTIP 

      

400 84 24 

200 10.5 3 

100 1.3 0.375 

50 0.16 0.047 

25 0.02 0.006 
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From Table 5.3 we can see that as the particle sizes of the spherical host titania 

particle decreases, we need more TTIP to fill in the necks and form the interconnections. 

If we use smaller host particles with improved surface area, then from Table 5.3 we can 

get a starting point in terms of concentration of TTIP needed to form an interconnected 

titania electrode structure. Therefore the 2-D microstructures obtained by spin coating 

can be very useful in helping us design 3-D electrode microstructures and can provide the 

kinds of recipes that will lead to well interconnected titania electrodes in dye sensitized 

solar cells.  

 

5.5 Summary 

 Silica-titania sub-monolayers were obtained by spin coating a titanium 

isopropoxide sol containing silica particles onto plain glass substrates. The sub-

monolayers were characterized by SEM to observe the morphology and the pore structure 

of the silica-titania interconnected chains. SEM imaging using the secondary electron 

detector provides topographical distribution of the silica-titania chains. Imaging with the 

in-lens detector enables better observation of the drying process in the layer and better 

observation of the neck formation and chain breakage. It is believed that the formation of 

liquid bridges between the silica particles during spin coating and further reaction/heat 

treatment give rise to interparticle necks composed of titania. Image analysis was used to 

measure the average neck width and 2-particle length in the sub-monolayers for 4 

concentrations of the titanium isopropoxide. AFM was used to look at surface 

topography. Both SEM and AFM show that the morphology of sub-monolayers consists 

of short chains of silica particles joined at the necks by titania. Image analysis confirms 
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preferential collection of titania at the necks between the silica particles. TEM analysis 

pointed to extremely thin titania layers on silica particles. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

123 

Chapter 6. Conclusions and Future Work 

6.1 Conclusions 

Dye sensitized solar cells (or Grätzel cells) were developed by Michael Grätzel 

and Brian O'Regan in 1991. In contrast to the all-solid conventional semiconductor solar 

cells, the dye-sensitized solar cell is a photoelectrochemical cell i.e. it uses a liquid 

electrolyte or other ion-conducting phase as a charge transport medium. Unlike a silicon 

solar cell, the task of light absorption and charge carrier transport are separated in a 

DSSC. Light is absorbed by a sensitizer, which is anchored to the surface of a wide band-

gap semiconductor, such as titanium dioxide. Charge separation takes place at the 

interface via photo-induced electron injection from the dye into the conduction band of 

the semiconductor. Carriers are transported in the conduction band of the semiconductor 

to the charge collector.  

DSSCs are extremely promising because they require low cost materials and can 

be fabricated with cost effective approaches onto glass or flexible substrates. However a 

lot of challenges in commercialization of this technology remain. These include:  

 Exploring new dye photo-sensitizers with optimum HOMO/LUMO and broader 

absorption spectrum to increase efficiency.  

 Exploring new room temperature ionic liquids to replace electrolytes containing 

volatile solvents, to improve stability of the cell.  

 Developing low temperature approaches to manufacture titania electrodes onto 

flexible substrates – This research work has been focused on the development of 

low temperature sintering methods for titania electrodes to improve the stability 
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and efficiency of flexible DSSCs, and at understanding the microstructure 

evolution processes that apply for reactive sintering processes in general.  

Initially the low temperature approach pursued in this study consisted of using a 

nanoparticle titania (Degussa P25) and a titanium alkoxide precursor. The hydrothermal 

treatment of the titania precursor (under neutral pH) converted it to titania through a sol-

gel condensation process and this titania formed interconnections between the P25 

particles. This low temperature sintering process has led to better performance in dye 

sensitized solar cells. The efficiency of DSSCs was highest when the weight ratio of 

P25:TTIP was 1:0.25. The increase in efficiency is attributed mainly to the increase in Isc 

which shows that the electron transport has improved by addition of TTIP. Beyond a wt% 

of 50% however the efficiency dropped: probably due to high amounts of incompletely 

converted titania from the TTIP. This observation is supported by electrochemical 

impedance spectroscopy studies which show reduced impedance and improved electron 

lifetime in the titania layer for an addition of 25% wt% TTIP to P25. 

 In order to further study the process by which the titania precursor led to the 

formation of titania interconnections, it was necessary to replace the P25:TTIP system, 

since it did not allow for good titania signal contrast in I-V response, SEM or XRD. 

Therefore we used amorphous silica as a nominally inert host particle matrix – within 

which the titania can react and its effects be measured: to help understand how and where 

the reacting titania is formed. When spherical 500 nm silica particles were used and a 

post heat treatment process added to the hydrothermal processing steps, anatase titania 

particles are formed in silica-titania coatings and these show photoactivity in solar cells 

and moderate new surface area creation. The efficiency of the silica-titania based DSSCs 
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are very low (<1%) but it can be improved by increasing the amount of titania (varying 

the silica-titania ratio).  

Silica particles of three different morphologies were tested to determine the 

influence of host silica framework morphology on the efficiency of DSSCs. The 

efficiency is shown to be higher when larger non-porous silica particles are used and thin 

nanocrystalline titania is coated on this superstructure. This observation is supported by 

the BET data which showed marked improvement in specific surface area in the silica-

titania powders for the 500 nm silica particles. If the host silica particles are themselves 

highly porous (as seen in the 20 nm and 80 nm silica particle cases) surface tension 

effects during coating and precursor reaction seem to draw the material into the necks and 

tiny pore regions; and not enough reactive material is left to build good conduction 

pathways on the surface.  

To probe deeper into the silica-titania framework and look closely at the neck 

regions, we have spin coated thin sub-monolayers of silica-titania onto glass substrates 

and used SEM, AFM and TEM characterization techniques to probe the sub-monolayers. 

During the spin coating process, surface tension pulls nearby hard-sphere silica particles 

into direct contact. Liquid bridges are formed leading to necks after reaction and heat 

treatment. This novel approach of forming sub-monolayers enabled us to directly 

measure the titania neck formation between pairs of silica particles and the pore sizes in 

silica particle clusters by image analysis. The neck width decreases by 43% and the 2-

particle length decreases by 15% as we reduce the titania precursor amount in the 

solution from 0.75 to 0.0156 mL. This means that by decreasing the titania precursor 

amount by a factor of almost 98% the neck width has decreased by only 43% - indicating 
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preferential collection of titania at the neck regions. It also shows that in the context of 

interparticle connections in a DSSC, very low amounts of titania precursor can provide 

relatively good particle-to-particle contact material at the neck regions. 

Towards low temperature sintering methods for dye sensitized solar cells, the 

results obtained in this research enable us to propose an electrode configuration in which 

spherical titania particles are used instead of the P25 nanoparticles and are joined at 

interparticle necks by the hydrolysis/condensation of a titanium alkoxide precursor. We 

have shown that very little amounts of titanium alkoxide precursor are enough to create 

interparticle contacts and used the 2-D microstructure data to extract quantitative 

information to design 3-D microstructures. 

The unique approach we have followed in obtaining silica-titania submonolayers 

to probe interparticle interconnections can be applied to a wide variety of mixed oxide 

and core-shell type of materials. The liquid phase locations in these microstructures are 

very closely related to other liquid phase arrangements found in composites, either by 

reactive sintering or liquid phase sintering: there are similar surface tension effects 

driving microstructural changes; and, similar shrinkage and contact morphologies matter 

for many systems.  

Also, the observational tools and the model system approach we have developed 

could be applied to many systems that are also of interest for numerous optical and 

mechanical applications. 
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6.2 Future work 

The focus of this research work has been on understanding the reactive sintering 

process with respect to its application to dye sensitized solar cells. While much progress 

was made in probing the process of formation of interparticle necks, there is a lot of 

scope for applying the insights gained in this research to further testing. In particular 

there is a need to test an electrode configuration consisting of spherical titania particles 

covered in a thin hydrothermally formed titania superstructure in dye sensitized solar 

cells. A majority of cells tested in this research were made on glass substrates but there is 

a need to expand testing to flexible substrates such as PET (polyethylene terephthalate). 

Both efficiency and mechanical stability of cells prepared using a low temperature 

sintering method on flexible substrates needs to be determined.  

 

Surface area and pore size distribution: 

Surface area and pore size distribution of the low temperature sintered powders 

prepared using P25 and titanium isopropoxide needs to be known to determine the 

change in the pore structure of P25 due to the hydrothermal treatment. The surface area 

of commercial P25 powder is approximately 50.0 m
2
/g. The surface area of the 

P25+TTIP powders prepared by steam treatment will depend on whether the titania 

formed during the process coats the P25 particles in addition to forming interconnections. 

An increase in surface area could be beneficial for increasing the short circuit current 

(and efficiency) because it will lead to an increase in the amount of adsorbed dye. On the 

other hand, if the TTIP forms amorphous titania which coat the crystalline P25 particles, 

it might lead to a decrease in cell efficiency. 
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Another important property that can be studied is the pore size distribution. It will 

be interesting to see how the titania formed at the interconnections changes the 

micropore/mesopore configuration of the P25/titania coating. Song et al. [93] studied the 

hydrolysis of TTIP at different water concentrations and found that the titania powders 

dried at 150 °C and for all molar ratios of H2O/TTIP used (5, 20, 200 and 1000) showed 

bimodal pore size distributions; consisting of intra-aggregated pores with maximum pore 

diameters from micropores to 3.3 nm and interaggregated pores with maximum pore 

diameters of ca. 60 nm. They compare the pore-size distribution of one of powders (the 

R20 powder prepared with molar ratio H2O/TTIP=20) calcined at 500 °C to the Degussa 

P25 powder. Both the powders had comparable surface areas (~50-60 m
2
/g). The pore-

size distributions they report suggest that the P25-titania powders made by steam 

treatment should possess micropores in addition to the mesopores from the P25. This will 

be an interesting result because it will show that in addition to the formation of 

interconnections, the porosity changes due to the addition of TTIP would play an 

important role in enhancing the efficiency of DSSCs.  

 

Nanoindentation: 

The microstructural properties of the titania films will depend on the processing 

conditions and the nature of interparticle connections. Nanoindentation is a technique that 

can estimate mechanical properties of thin films such as hardness and elastic modulus. 

Indentation techniques have been applied to study steam treated titania coatings on NiTi 

surfaces [94] and sol-gel titania coatings on glass and copper substrates [95]. 
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 As a future progression of the work that we have done on silica-titania sub-

monolayers, nanoindentation can be used to study mechanical properties of silica-titania 

and P25 based titania films for different processing temperatures and titania precursor 

concentrations.  

Applications of silica-titania materials: 

Titania-silica materials have been extensively used as photocatalysts [96,97] , as 

protective coating on stainless steel to resist oxidation and chemical attack [98], 

antireflection coatings for optical glasses [99], and as very interesting glass materials 

with ultralow thermal expansion coefficients [100,101] and high refraction indices [102]. 

Such advanced titania-silica materials not only take advantage of both TiO2 (an n-type 

semiconductor and an active catalytic support) and SiO2 (high thermal stability and 

excellent mechanical strength), but also extends their applications through the generation 

of new catalytic active sites due to the interaction of TiO2 with SiO2. 

The silica-titania materials that have been obtained in this study show modest 

efficiencies in dye sensitized solar cells. But their potential for applications in the 

aforementioned areas needs to be explored. Heterogeneous photocatalysis has shown a 

high efficiency in the removal of highly toxic and non-biodegradable pollutants 

commonly present in air and in domestic or industrial wastewaters and silica-titania based 

materials have shown a lot of promise in this field [103,104]. Therefore, there is a lot of 

scope for future work on using the silica-titania materials we have developed as 

promising cost efficient photocatalysts with applications in water purification. 
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APPENDIX A 

 

List of Abbreviations 

 

 

 

DSSC  Dye sensitized solar cell 

TCO  Transparent conducting oxide 

FTO  Fluorine doped tin oxide 

ITO  Indium tin oxide 

Voc  Open circuit voltage 

Isc  Short circuit current 

FF  Fill factor 

TTIP  Titanium tetra isopropoxide 

EIS  Electrochemical impedance spectroscopy 

PET  Polyethylene terephthalate 

PEN  Polyethylene naphthalate 

MLCT  Metal to Ligand Charge Transfer 

AFM  Atomic force microscopy 

BET  Brunauer-Emmett-Teller  

SEM  Scanning electron microscopy 

HRTEM  High Resolution Transmission electron microscopy 

XRD  X-ray diffraction 

RH  Relative Humidity 
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APPENDIX B 

 

ImageJ Instructions  

(Adapted from :http://rsbweb.nih.gov/ij/docs/pdfs/ImageJ.pdf) 

Courtesy: Larry Reinking 

Department of Biology, Millersville University 

Millersville, PA 17551  

larry.reinking@millersville.edu 

ImageJ Basics 

(Version 1.38) 

ImageJ is a powerful image analysis program that was created at the National 

Institutes of Health. It is in the public domain, runs on a variety of operating systems and 

is updated frequently. You may download this program from the source 

(http://rsb.info.nih.gov/ij/) or copy the ImageJ folder from the C drive of your lab 

computer. The ImageJ website has instructions for use of the program and links to useful 

resources. 

Installing ImageJ on your PC (Windows operating system) 

Copy the ImageJ folder and transfer it to the C drive of your personal computer. 

Open the ImageJ folder in the C drive and copy the shortcut (microscope with arrow) to 

your computer‟s desktop. Double click on this desktop shortcut to run ImageJ. See the 

ImageJ website for Macintosh instructions. 

ImageJ Window:  

The ImageJ window will appear on the desktop; do not enlarge this window. Note 

that this window has a Menu Bar, a Tool Bar and a Status Bar. 

http://rsbweb.nih.gov/ij/docs/pdfs/ImageJ.pdf
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Adjusting Memory Allocation: Use the Edit → Options → Memory command to adjust 

the default memory allocation. Setting the maximum memory value to more than about 

75% of real RAM may result in poor performance due to virtual memory "thrashing". 

Opening an Image File: Select File → Open from the menu bar to open a stored image 

file. 

Tool Bar: The various buttons on the tool bar allow you measure, draw, label, fill, etc. A 

right-click or a double left-click may expand your options with some of the tool buttons. 

Area Selection Tools: The first four buttons on the tool bar allow you to surround an 

area on the image with a rectangle, oval, polygon or freehand shape. After selection, 

these areas may be altered, analyzed, copied, etc. using the menu commands. Note that 

the status bar, below the tool bar, gives information such as the coordinates (xx, yy) of 

the selection on the frame. 
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Line Selection Tools: This button allows you to create straight, segmented or freehand 

lines (right-click to select line type). Information about the line is displayed on the status 

bar. Double-click on the button to alter the line width, select Analyse → Measure (or 

Ctrl+M) to record a line length and Edit → Draw (or Ctrl+D) to make a line permanent. 

Angle Tool: Draws two intersecting lines and measures the formed angle. 

Point Tool: When „Auto-Measure‟ is selected, this tool allows you to mark locations on 

an image; with each click the coordinates of the mark (xx, yy) and brightness values (0-

255) are recorded in a data window. Color images will have three brightness readings 

displayed on the status bar, one each for the red, green and blue channels, however only a 

single grayscale brightness value will appear in the data window. 

Wand Tool: This tool automatically finds the edge of an object and traces its shape. It 

works best with high contrast images (see Thresholding, next page). Place the wand to 

the left of an edge; click and the algorithm will search to the right for an edge. It will then 

trace along the edge of the object until it returns to the starting point. 

Text Tool: Double click on this button to select a font and size. A large font size will 

probably be required for an image from a high resolution digital camera. Single click the 

button, click-drag a text box and type the label. Move the box to the desired location and 

permanently set the text in place with Edit → Draw (or Ctrl+D). Use the color picker tool 

to select font color. 

Magnifying Glass: Left-click on the image to magnify; right-click to reduce the image 

size. 

Scrolling Tool: This button allows you to move an image if it is larger than the window. 

Pressing the keyboard space bar is a shortcut that temporarily activates this tool. 
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Color Picker: This tool sets the foreground drawing/text color when a color on an image 

is „picked up‟ with the eyedropper. Colors also may be selected from the Colors window 

by double-clicking the color picker button (or via Image → Color → Color Picker). Use 

Alt+click to change the background color. The icon for this tool (eye dropper) shows the 

current foreground color while the frame around it shows the background color. 

Other Tools: The remaining tool buttons are similar to those found in drawing programs 

(spray can, flood fill, etc.) and can be easily used after a bit of experimentation. 

----------------------------------------------------------------------------------------------------------- 

Image Editing and Analysis 

The following is a small sampling of processing techniques that are possible with 

ImageJ. ImageJ can be used in conjunction with a photo editing program such as Adobe 

Photoshop. During analysis, measured values can be easily transferred to a spreadsheet 

with a „cut and paste‟. It is a very good idea to make a backup copy of your image before 

doing any processing. Refer to the ImageJ and NIH Image websites for more information 

Undo. Edit → Undo reverses the preceding action. Only one back-step is possible. 

Revert. File → Revert converts all changes back to the original saved version. 

Cropping. Surround the area with the rectangular selection tool followed by Image → 

Crop. 

Clear Outside. Make a perimeter with an area selection tool followed by Edit → Clear 

Outside. This technique is useful for clearing extraneous objects near an area of interest. 

Edit → Clear clears inside of the perimeter. 

Enhancing Brightness and Contrast. Image → Adjust → Brightness/Contrast; click 

'Auto' or set manually with the sliders. Also try Process → Enhance Contrast. 



 

 

135 

Removing Noise. Process → Noise → Despeckle or try Process → Filters → Median 

Rotating an Image. Image → Rotate and select type of rotation 

Converting to Grayscale. Image → Type → 8-bit converts the image to 256 shades (8-

bit) of gray. In this scale 0 = pure black and 255 = pure white…. a grayscale reading of 

128 would be a medium gray. 

Thresholding (Binary Contrast Enhancement). This is commonly used when detecting 

edges, counting particles or measuring areas. A grayscale image is converted to binary 

(a.k.a. halftone or black & white) by defining a grayscale cutoff point. Grayscale values 

below the cutoff become black and those above become white. The procedure: First 

convert the image to 8-bit grayscale as described above (Image → Type → 8-bit). Create 

a 'thresholded' binary image by selecting Process → Binary → Make Binary. A less 

automated procedure involves: 

Image → Adjust → Threshold; use the slider to adjust the threshold. The red areas will 

become the black portions in the binary image. Click 'Apply' to complete the conversion. 

'Brightness slicing' is a similar procedure that uses both upper and lower threshold values. 

----------------------------------------------------------------------------------------------------------- 

Measuring and Counting Objects 

Setting Measurement Scale. Draw a line between two points of known distance such as a 

ruler on the photograph. Go to Analyze → Set Scale. In the Set Scale window the length 

of the line, in pixels, will be displayed. Type the known distance and units of measure in 

the appropriate boxes and click OK. Measurements will now be shown using these 

settings. If the pixel:length relationship is known from a previous measurement you may 
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directly type this information in the Set Scale window. Check 'global' to apply this scale 

to other image frames. 

Set Measurements. Choose parameters to be measured via Analyze → Set 

Measurements. 

Measuring Distance Between Points. Draw a line between two points. The status bar will 

show the angle (from horizontal) and the length. Analyze → Measure (or Ctrl+M or 

simply type M on the keyboard) transfers the values to a data window. 

Measuring Area. Surround an area with a perimeter. This can be done with an area 

selection tool, the wand (for high contrast images) or with Analyze Particles (see below). 

Analyze →Measure (or keyboard M) transfers the area measurement to a data window. 

Counting Particles. As described above, convert the image to 8-bit grayscale and then 

'threshold' the image.  

Go to Analyze → Analyze Particles, type the upper and lower limits for the particle size, 

toggle 'show outlines' and check „Display Results‟. Click OK and each counted particle 

will be outlined and numbered in a new widow (numbers may be very small). 

The data window contains measurements for each particle. 

----------------------------------------------------------------------------------------------------------- 

Saving Files. Images from digital cameras are usually saved as JPEG files. JPEG is a 

type of memory compression that results in the loss of some data. A JPEG image 

degrades each time it is opened, edited and resaved. It is best to save a file in a 'lossless' 

format such as a TIFF during the editing process (File → Save As → Tiff). 

Printing. Should you encounter printing problems, save the processed image and print 

with a photo editor. Saved images also may be inserted into MS Word for printing. 
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APPENDIX C 

 

Calculation of molar ratio of TTIP needed for interconnections in 10 micron thick 

titania electrode in a DSSC: 

Consider the smallest neck (neck width=173nm) that was obtained in our experiments for 

a TTIP concentration = 0.015625mL in solution or moles/liter TTIP = 0.0052  

 

Calculation of number of interparticle necks: 

Consider a solar cell (cell area exposed to light = 0.25 cm
2
) tested in the solar simulator:  

 

Volume of the solar cell = 0.25cm
2
 * 10 micron = 2.5* 10

-10
 m

3
 = Vcell 

Assume the average diameter of a silica particle is 400nm.  

Volume of 1 silica particle = (4/3)*π*R
3
 = 3.351 * 10

-20
 m

3
  

Consider a porosity of ~65% (optimum porosity for a titania electrode in a DSSC is 

around 60-70%) 

 

Volume of silica for a porosity of 65% = 0.35*Vcell =8.75 *10
-11

 m
3
 = Vsilica 

Number of silica particle in a cell with 65% porosity  

= Vsilica/ volume of one silica 

particle 

 = 2.611 * 10
9
 = N 

Average coordination number for a film with a porosity of 65% is between 3.5 and 

4[105]. For the sake of simplicity we have considered a coordination number of 4.  
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This means that each silica particle has 4 nearest neighbors and therefore 4 interparticle 

necks which means the number of necks per silica particle is 2N 

Therefore number of interparticle necks in the solar cell electrode ~ 5.222 * 10
9
 

 

Calculation of the volume of titania in the necks: 

For a neck width of 173nm and neck height of 30nm (obtained from image analysis) we 

can approximate the neck to a cylinder and obtain its volume 

 

Volume of a neck = π*R
2
*h= π*(86.5)

2
*30= 7.0519*10

-22
 m

3 
= Vneck 

Total volume of titania necks in the solar cell = Vneck*2N ~ 3.6825*10
-12

 m
3
 

Calculation of TTIP molar concentration:  

Number of moles of titania in a volume of 3.6825*10
-12

 m
3 

can be calculated using its 

density (3.9g/cc) and its molecular weight (79.90). This gives 

Number of moles of titania present in the interparticle necks= 3.6825*3.9*79.9*10
-6

 

      

  = 0.001155 moles  

Since 1 mole of TTIP is needed per mole of titania we get the number of moles of TTIP 

needed to form interconnections in  the solar cell = 0.001155 moles TTIP or 

Weight of TTIP required= 4.064*10
-6

g=W1 (molecular weight of TTIP=284.22) 

If we used spherical 400nm titania particles in place of the 400nm silica particles in the  

matrix then we can estimate the molar ratio or the weight ratio of 400nm titania/TTIP as 

follows: 
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Volume of 400nm titania particles = 8 .75 *10
-11

 m
3
 (same as Vsilica)  

Weight of 400nm titania = 8 .75 *10
-5

*3.9 = 3.4125*10
-4

 g =W2 

Weight ratio of 400nm titania:TTIP = W2/W1 = 83.96 ~84  

Molar ratio of 400nm titania:TTIP= 84*79.9/284.22 = 23.61 

The weight ratio of spherical 400nm titania to TTIP is approximately 84. Referring back 

to Chapter 2 (section 2.3.3.1) we see that the weight ratio of P25:TTIP that gave the best 

efficiency is 1/0.25=4. This shows that the amount of TTIP required to form 

interconnections would probably be much less if we used spherical titania in the bulk 

matrix instead of P25. 
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